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Important safety instructions

• Read the instructions.

• Keep these instructions.

• Follow all instructions.

• Do not use this apparatus near water.

• Clean only with a dry cloth.

• Install only in accordance with the manufacturer’s instructions.

• Refer all servicing to approved service personnel.

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, 

DO NOT EXPOSE THIS APPARATUS TO RAIN OR MOISTURE.

This apparatus has been designed with Class 1 construction and 

must be connected to a mains socket outlet with a protective 

earthing connection (the third grounding pin).

This apparatus uses a single-pole power switch. As a result it is 

not isolated from AC mains power when switched off at the rear 

panel. The apparatus may be isolated from mains power either by 

unplugging the power connector from the rear of the unit, or by 

unplugging the connector at the opposing end of the power cord 

or cable from its supply outlet. As a result, either or both of these 

connectors should remain accessible

Safety warnings
• Do not expose the product to dripping or splashing.

• Do not place any object filled with liquid, such as a vase, on the 

product.

• Do not place naked flame sources, such as lighted candles, on the 

product.

To avoid interference
Do not position the product:

• Near strong magnetic radiation, such as near a power amplifier.

• Near to a television, or where connecting cables may be subject 

to or cause interference.

To avoid overheating
• Leave at least 10cm around the equipment to ensure sufficient 

ventilation.

Do not position the product:

• In direct sunlight.

• Near heat sources, such as a radiator.

• Stacked with any other audio products, as the heat it generates 

may damage the other products.

• On a soft surface, such as a carpet, which would obstruct the 

ventilation holes in the base.

The product normally runs warm to the touch.

Radio interference
FCC Warning: This equipment generates and can radiate radio 

frequency energy and if not installed and used correctly in 

accordance with our instructions may cause interference to radio 

communications or radio and television reception. It has been type-

tested and complies with the limits set out in Subpart J, Part 15 of 

FCC rules for a Class B computing device. These limits are intended 

to provide reasonable protection against such interference in home 

installations.

EEC: This product has been designed and type-tested to comply 

with the limits set out in EN55013 and EN55020.
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Introduction
This guide provides full information about unpacking the C61R Digital Surround Controller, 

connecting it to the other equipment in the system, and configuring it using the front panel.

Once you have connected and configured the product, refer to the G Series System Guide for 

information about operating it.

The C61R is a powerful, flexible surround controller, with 8 

unbalanced analogue outputs and 10 digital outputs.

At the heart of the C61R is a powerful DSP engine consisting 

of three Motorola 56367s running at 150MHz – delivering an 

incredible 450MIPS (million instructions per second) capability. 

Processing is performed at high sample rates and with 48-bit 

precision throughout, ensuring that all filtering, processing, and 

other operations are carried out beyond the limits of human 

hearing. The C61R is thus a perfect processor for the very latest in 

digital audio, such as DVD-Audio and DVD-Video.

Inputs
Analogue signals are converted via a 24-bit Delta-Sigma converter 

to high-sample-rate digital on input to the processor, while all 

digital signals are reclocked to minimise jitter and maintain total 

data integrity. The C61R includes two six-channel S/PDIF digital 

inputs (coax), a USB audio input, four TOSlink optical inputs, and 

six more stereo coax digital inputs. In addition, there is a six-

channel analogue input, and five stereo analogue inputs.

Formats supported

The C61R combines controller and surround processor functions, 

meeting the latest THX specifications and including MPEG, DTS, 

Dolby, Trifield, and Ambisonic decoding. In many cases the decoders 

incorporate our own code, giving them superior integration with 

the Meridian design philosophy, as well as superior performance. 

As a result, the C61R can decode surround signals from all PCM 

optical discs. The C61R is thus an ideal complement to a G Series 

optical disc player like the G98.

Smart Source feature

The C61R’s ’Smart Source’ feature continually monitors the digital 

inputs and automatically loads the correct decoding software for 

the format, speaker layout, and encoding of the incoming signal. 

This capability is enhanced by MHR SmartLink, which provides a 

digital link between a Meridian optical disc player and processor, 
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carrying explicit information about the nature of the datastream as 

well as encrypted high-resolution digital signals from DVD-Audio 

– the first system of its kind to be approved. Virtually all other 

manufacturers oblige you to go through an analogue connection, 

losing quality in the process.

You can also store separate parameters for each source (such 

as DVD) depending on whether the incoming signal is stereo or 

surround, so that any source material is played with the DSP mode 

of your choice.

Meridian Room Correction

The C61R incorporates Meridian Room Correction, a unique system 

that compensates for acoustic deficiencies in your listening room, 

particularly at the bass end. It achieves this by automatically 

analysing the room response and then using powerful Digital 

Signal Processing (DSP) technology to build a set of filters, called a 

profile. This audibly improves the sound by eliminating resonances 

and making the decay time consistent for frequencies below about 

250Hz.
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Specifications

Digital coax inputs 6 coax digital inputs, 2 6-channel coax inputs, all MHR.

USB input 1 USB digital input allows connection to a Windows PC or Macintosh.

Digital optical inputs 5 optical digital inputs.

Analogue inputs 8 stereo unbalanced inputs; A1-A3 and A4-A6 can be used as two 6-channel unbalanced inputs.

Digital outputs Main, Centre/Sub, Sides, Rears, A/B*.

Unbalanced analogue 

outputs

Main L/R, Centre/Sub, Rears, LZ/RZ†.

Trigger outputs 3 12VDC/100mA trigger outputs configurable by source.

Comms 2 5-pin 240º DIN sockets, BNC socket, USB, RS232 interface.

Conversion Up to 192kHz, 24-bit Sigma-Delta conversion on all analogue inputs and outputs.

Formats Include Dolby Digital, DTS, MPEG Surround, and AAC.

DSP modes Direct, Music, Trifield, Ambisonics, Super, Stereo, MusicLogic, Mono, TV Logic, PLIIx Music, PLIIx Movie, PLIIx 

THX, Discrete, Cinema, PLIIx Mov6, PLIIx Mus6, THX, THX Surround EX, THX Ultra2 Cinema, THX Music.

Power Universal supply 100-240V, 50-60Hz, 40W. 

Processing 3 Motorola 56367s running at 150MHz to give a total of approximately 450MIPS. 48-bit arithmetic 

throughout.

Dimensions 440mm x 90mm x 350mm (17.32" x 3.54" x 13.78") WHD.

Weight 8.5kg (18lb) approx.

Controls Front-panel soft keys include control of Source, Preset, etc. Standby and display buttons, volume control, 

mute. Full remote control of all features via MSR+.

Display Multi-character dot-matrix Vacuum Fluorescent Display.

Indicators Standby button lit when off.

*A/B: Subs if two or three subs are used. Optional ceiling speakers with future software update.  

†LZ/RZ: May be chosen to be any pair from: Main L/R, Centre/Sub, Sides, Rears, Subs. 

Note: Current software supports a maximum of eight outputs. Future software may support up to 12.
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Installing the digital surround controller

Unpacking
The C61R Digital Surround Controller is supplied with the following 

accessories:

• MSR+ remote control with batteries, manual, and spare key caps.

• Meridian Comms lead.

• Power cord.

• This manual.

• Meridian G Series System Guide.

If any of these items are missing please contact your dealer.

Note: You should retain the packaging in case you need to 

transport the unit.

This chapter explains how to install the digital surround controller. It describes what you 

should find when you unpack the product, and how you should connect it to the other 

equipment in the system.

You should not make any connections to the product or to any other component in the 

system while the AC power supply is connected and switched on.
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Audio inputs
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G61 SURROUND CONTROLLER DESIGNED        AND MADE IN ENGLAND BY MERIDIAN AUDIO LTD     DESIGN AND COPYRIGHT 2005

D11 D9 VCR2

D12 D10

DIGITAL INPUT

OPTICAL INPUT

OPTICAL INPUT

USB
AUDIO IN

O3O4
U1

O2 GAME O1 SAT

D8 DISC

D7 CD 

Digital coax inputs 

USB input

Multichannel analogue inputs 

Multichannel digital coax inputs 

Optical inputs

Analogue inputs 

Use this connector To connect to this

MULTI DIGITAL INPUT 1 (DVD) or D1-D3, 

MULTI DIGITAL INPUT 2 or D4-D6

The multichannel digital output of a source such as the G98DH DVD Audio Transport, or 

three digital sources.

DIGITAL INPUT D7 (CD), D8 (DISC), D9 

(VCR2), D10-D12

The digital output of a source such as a G07 24-bit CD Player or DAB tuner.

MULTI ANALOGUE INPUT 1 (AUX) or A1-A3 A multichannel analogue source such as an SACD player.

ANALOGUE INPUT A4 (TAPE), A5 (TV),  

A6 (CABLE), A7 (VCR1) *

The unbalanced analogue output of a source such as a tape recorder, TV tuner, cable box, 

or VCR.

USB INPUT U1 A computer USB port.

OPTICAL INPUT O2 (GAME), O3-O5 The optical output of a source such as a satellite receiver or computer game console.

ANALOGUE IN MIC (A8-L) An SPL meter for use in room correction configuration.

* A4-A6 can be used as MULTI ANALOGUE INPUT 2 to connect to a second multichannel analogue source such as an SACD player.

The default assignment of the sources to each input is shown in brackets after the input name in the above table. To assign a different 

input to a source see Configuring sources, page 22.
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You can connect up to 12 digital coax sources to the C61R Digital 

Surround Controller.

• Connect the digital source to one of the digital input sockets of 

the digital surround controller, using a 75Ω screened coax phono 

lead.

If the source is a Meridian product connect together the COMMS 

sockets using the Comms lead provided.

To connect to a digital source (eg G06 24-bit CD Player)

C61R Digital Surround Controller

DIG IN 
D7 CD 

DIGITAL LEAD 
COMMS LEAD 

COMMS

DIGITAL OUT COMMS

G06 24-bit CD Player

To connect to an analogue source (eg TV tuner)

TV tuner 

OUTPUT

PHONO LEADS 

C61R Digital Surround Controller

ANALOGUE INPUT 
A5 TV   

You can connect up to eight analogue sources to the C61R Digital 

Surround Controller.

• Connect the analogue source to one of the analogue input 

sockets of the digital surround controller, using screened coax 

phono leads.
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To connect to a DVD-Audio player with digital multichannel outputs (eg G98DH DVD Audio Transport)

G98DH DVD Audio Transport 

3 x DIGITAL LEADS 
COMMS LEAD 

C61R Digital Surround Controller

MULTI  
DIGITAL INPUT 

(DVD)

COMMSCOMMS

MAIN DIGITAL OUT 

The C61R Digital Surround Controller provides 12 digital coax 

inputs, six of which can be used as two multichannel inputs from 

a source with a suitable digital multichannel output, such as the 

G98DH DVD Player.

• Connect the MAIN DIGITAL OUT on the G98DH to the MULTI 

DIGITAL INPUT 1 on the C61R, using three 75Ω screened coax 

phono leads.

• Connect together the COMMS sockets using the Comms lead 

provided.

To connect to a computer via USB

Computer

USB

USB A-B CABLE

C61R Digital Surround Controller
USB INPUT

You can connect a Windows PC or Macintosh to the C61R via the 

USB input to allow you to use the C61R as a digital audio output 

device.

On a PC, Windows XP/SP2 or later is required. On a Macintosh, 

OSX 10.4 or later is recommended. Linux computers that support 

USB audio class drivers can also be used.

• Connect the computer’s USB port to USB INPUT U1 on the C61R 

using a standard USB A-B cable. The flat rectangular end plugs 

into the PC and the square end into the C61R.

The first time that the C61R is plugged in to the PC or Macintosh 

it will automatically be recognised, and appropriate drivers will 

be installed. The C61R will then appear as a sound output device 

called Meridian 48k/16 in the Sound control panel (PC) or 

Sound system preferences panel (Macintosh).

Note: The computer volume control will have no effect on the 

playback volume; use the Meridian system control instead. 
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To connect to a source with analogue multichannel outputs (eg SACD or DVD-A player)

SACD/DVD-A player 

6 x PHONO LEADS 
DIGITAL LEAD 

C61R Digital Surround Controller

MULTI ANALOGUE
INPUT 1

MULTICHANNEL 
OUTPUT DIGITAL INPUT  

D8 DISC 
DIGITAL 
OUTPUT

Analogue inputs A1 to A3 can be used as a multichannel input 

from a source with a suitable analogue multichannel output, such 

as an SACD player. Analogue inputs A4 to A6 can optionally be 

used as a second multichannel analogue input.

• Connect the ANALOGUE OUTPUT sockets from the source to the 

analogue multichannel inputs on the digital surround controller 

using six phono leads.

• Optionally connect a digital output from the source to digital 

input D8 (DISC) on the digital surround controller, using a digital 

phono lead.

You can then select the source corresponding to the multichannel 

input (AUX) for playing surround material, and the source 

corresponding to the digital input (DISC) to decode other formats.

Note: Multichannel analogue sources may have subwoofer level 

outputs that vary by up to 10dB, so it may be necessary to reduce 

the LFE level to give correct bass integration; see DSP presets, page 

85.
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Audio outputs

The C61R hardware architecture is designed to process up to 12 

completely independent output channels. Currently the software 

limits the number of outputs to a total of eight: Main L/R, Centre, 

Sub, Rears, and either Sides or two more additional subwoofers.

The C61R provides analogue and/or digital output sockets for these 

eight speakers. 
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DIGITAL OUTPUT 

OPTICAL INPUT 

MULTI DIGITAL INPUT MULTI ANALOGUE INPUTANALOGUE INPUT D11 D9 VCR2

D12 D10

DIGITAL INPUT

OPTICAL INPUT

OPTICAL INPUT

USB
AUDIO IN

O3O4
U1

O2 GAME O1 SAT

D8 DISC

D7 CD 

Analogue outputs 

Analogue outputs 

Digital outputs 

Use this output To connect to this

DIGITAL OUTPUT MAIN L/R, CENTRE/SUB, 

SIDES, REARS, A/B

Digital loudspeakers, using digital coax cables.

ANALOGUE OUTPUT LEFT, RIGHT, REAR L, 

REAR R, CENTRE, SUB, LZ, RZ

The unbalanced analogue input of a power amplifier or active loudspeakers, using 

screened coax phono leads.
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To connect the C61R to Meridian DSP loudspeakers

C61R Digital Surround Controller

DIGITAL OUTPUT

COMMS

511 S-patch box

S5 LEAD
(digital unused) M5 LEAD

S5 LEAD

S5 LEAD

DSP5200 – Centre (Master)

COMMS
INPUT OUTPUT

DIGITAL
INPUTS

2

1

DIGITAL
OUTPUT

SW1600    – Sub (Slave)

COMMS
INPUT OUTPUT

DIGITAL
IN OUT

S5 LEAD

S5 LEAD

S5 LEAD

DSP5200 – Main Left (Slave)

COMMS
INPUT OUTPUT

DIGITAL
INPUTS

2

1

DIGITAL
OUTPUT

DSP5200 – Main Right (Slave)

COMMS
INPUT OUTPUT

DIGITAL
INPUTS

2

1

DIGITAL
OUTPUT

DSP5200 – Surr Left (Slave)

COMMS
INPUT OUTPUT

DIGITAL
INPUTS

2

1

DIGITAL
OUTPUT

DSP5200 – Surr Right (Slave)

COMMS
INPUT OUTPUT

DIGITAL
INPUTS

2

1

DIGITAL
OUTPUT

• Use the Comms part of an M5 lead to connect one of the 

COMMS sockets on the C61R to the digital speaker you have 

chosen as the master (typically the centre speaker).

• Use the audio part of the M5 lead to connect the digital speaker 

to the appropriate digital output socket.

If the system includes more than two Meridian DSP loudspeakers 

you may use a 511 S-patch box (available separately) to link 

together the S5 leads from each speaker.

• Connect the COMMS output from the master digital speaker to 

one socket on the 511 using an S5 lead.

• Link each pair of speakers together with an S5 lead, out of 

the first speaker and into the second speaker, as shown in the 

diagram.

• Connect the inputs to the first speaker of each additional pair 

to the 511 (Comms) and the appropriate output of the C61R 

(audio), using an S5 lead.

The speakers should then be configured appropriately as master 

and slaves, and Left, Right, Centre, Surround; see Meridian DSP 

Loudspeaker User Guide for more details.
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To connect the C61R to power amplifiers or to analogue active and passive speakers powered by a Meridian G41

CHANNEL 1 INPUTS
1 3 4

A B

2

CHANNEL 3

G41 Powered
Crossover/AmplifierCHANNEL 2

CH. A CH. B

ANALOGUE OUT

C61R Digital Surround Controller

A330
Main right

A330
Centre

P330
Rear right

P330
Rear left

A330
Main left

Analogue subwoofer

COMMS
INPUT OUTPUT

PHONO

The C61R provides six analogue outputs to allow you to connect to 

six power amplifiers and passive loudspeakers, or 300 Series Active 

and Passive Installation Loudspeakers powered by the G41 Active 

Crossover Amplifier.

• Connect the LEFT and RIGHT analogue outputs to the power 

amplifier inputs for the main front loudspeakers. 

• Connect the SURR L and SURR R analogue outputs to the power 

amplifier inputs for the rear loudspeakers.

• Connect the CENTRE analogue output to the power amplifier 

input for the centre loudspeaker.

• If the system includes a subwoofer connect the SUB analogue 

output to an active analogue subwoofer, such as the Meridian 

SW1600.
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To connect to an active subwoofer (eg Meridian SW1600 or SW5500)

Subwoofer

PHONO LEAD 

C61R Digital Surround Controller
SUB

CROSSOVER 
INPUT

DIRECT
INPUT

The Meridian SW1600 and SW5500 subwoofers provide both 

digital and analogue inputs, allowing you to connect them to 

either the digital or analogue subwoofer outputs of the C61R. The 

analogue connection must be used if you do not have a digital 

main speaker.

• Connect the SUB analogue output socket from the C61R Digital 

Surround Controller to the subwoofer’s line-level input using a 

phono lead. 

Use RZ and LZ if you have two subwoofers.

The digital surround controller provides a very high-quality 

crossover for the subwoofer, and for best results you should use 

this instead of the subwoofer’s crossover. To do this remove any 

crossover in the subwoofer or set it to its highest setting (eg 

200Hz). The subwoofer crossover can be set from the front panel of 

the C61R; see Subwoofer crossover frequency, page 32.
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Communications connections
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G61 SURROUND CONTROLLER DESIGNED        AND MADE IN ENGLAND BY MERIDIAN AUDIO LTD     DESIGN AND COPYRIGHT 2005

D11 D9 VCR2

D12 D10

DIGITAL INPUT

OPTICAL INPUT

OPTICAL INPUT

USB
AUDIO IN

O3O4
U1

O2 GAME O1 SAT

D8 DISC

D7 CD 

Meridian BNC Comms 

Meridian DIN Comms 

Power & fuse 

USB connection

Infra-red repeater input 

Trigger output 1 

RS232 connection Trigger outputs 2 & 3 

Use this connector To connect to this

DIN COMMS Other Meridian C Series, G Series, or 800 Series equipment, or Meridian DSP loudspeakers.

BNC COMMS Other Meridian C Series or G Series equipment, or some Meridian DSP loudspeakers.

RS232 connection* A computer, for configuring the digital surround controller.

USB connection A computer, for configuring the digital surround controller.

IR IN A G12 IR Receiver, or approved alternative infra-red repeater. Contact your dealer for details.

TRIG 1, TRIG 2, TRIG 3 Other equipment, via mono 3.5mm jack plug outputs (centre pin hot) providing 12VDC. They are always low 

in standby. By default they are high for all sources, so can be used to bring a G Series power amplifier out of 

standby. Alternatively you can program them to be high for specific sources; eg to control a projection screen.

*A second RS232 socket is provided on the front panel, and a switch allows you to select the active connector.
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To connect to other Meridian C Series, G Series, or 800 Series equipment

COMMS

COMMS LEAD COMMS LEAD

C Series, G Series, or 800 Series unit 
COMMS

C61R Digital Surround Controller

In a system of Meridian products the products should be linked 

together in a chain, via the COMMS sockets, using the Comms 

leads supplied with each product. The sequence in which you 

connect the units is not important.

One of the products acts as the controller for the system, receiving 

infra-red commands from the MSR+, and then, if appropriate, 

relaying them to the other products via the Comms link. The 

following procedure should be used to set up the Comms correctly 

between several products:

• Switch all the units to standby.

• Press Clear (MSR+).

Each unit will display:

   Auto

One unit will then be designated as the controller, and display:

   Con.

All the other units will be configured as non-controllers, and 

display:

   Not Con.

The system is now ready for use.

If the automatic setup does not work, first make sure you are 

operating the MSR+ from a position where all the units can receive 

the infra-red, and try again. Then:

• Check that none of the units have been configured to be IR 

Controller; see Settings, page 25. Either all products should be 

set to Auto, or one should be configured as Controller and the 

others as Not Controller.

Note: Do not, under any circumstances, connect any equipment 

other than Meridian C Series, G Series, or 800 Series to any socket 

marked COMMS on the back of the product.
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Configuring the digital surround controller
This chapter explains how to configure the digital surround controller using the Configuration Wizard.

 Alternatively, for complete control over all aspects of the product’s configuration you can set up the unit 

from a computer using the Meridian Configuration Program; see Meridian Configuration Program, 

page 35.

Configuration Wizard
The Configuration Wizard leads you through the correct 

sequence to configure your digital surround controller. Alternatively, 

you can skip between the configuration stages, which allow you to 

reset the configuration, or configure the sources or other settings 

of the digital surround controller.

To run the Configuration Wizard

• If necessary press On/Off to put the digital surround controller 

into standby.

• Press More.

If the product is locked the display shows:

• Press Unlock to unlock it, then press More.

The displays then shows:

• Press Wizard.

Follow the sequence of configuration stages described in the 

following pages, pressing Next to proceed after each stage.

At any stage in the Configuration Wizard the following options are 

available:

To do this Press

Go back to an earlier configuration option Back

Return to the title screen for the stage Home

Exit from the configuration menus On/Off

Display help about the current option More
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The digital surround controller provides several alternative standard 

settings, called Types, which configure all aspects of the product 

into the most commonly needed configurations.

Choosing one of the Types overrides any other configuration you 

may have performed, and so can be used to reset the configuration 

of the unit. 

To reset the configuration

• Press Wizard.

The display shows the title screen for stage 1:

• Press Enter to proceed or Skip to go stage 2.

If you pressed Enter the display shows:

• Press Yes to proceed or Back to exit.

The display shows the current Type:

• Press A or V to step through the available Types. 

A description of the speakers for each type is shown on the top 

line of the display. As you select each Type the digital surround 

controller is reset to that Type.

When you have selected the Type you want:

Either:

• Press Next to proceed to configuring speakers, as described in 

the next section.

Or:

• Press On/Off to return to standby.

Stage 1: Resetting the product
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Types
The following table lists the available Types:

Type Speakers Music Sub Logic Sub 5.1 Movie Sub

0 All analogue. LFE Centre LFE

1 All analogue. Mono Mono Mono

2 All digital. LFE Centre LFE

3 All digital, large centre. None None None

4 Digital left, right, and centre. LFE Centre LFE

5 Digital left and right. LFE Centre LFE

Music Sub refers to a subwoofer used for all Music DSP presets, Logic Sub to a subwoofer used for all Logic DSP presets, and 5.1 Movie 

Sub to a subwoofer used for all 5.1 Movie DSP presets; see Speaker layouts, page 85.

LFE subwoofer is only active in multichannel presets. Mono and Centre Subwoofers are active in all presets.

Note that any Types stored using the Meridian Configuration Program will also be available in this list; see the Meridian Configuration 

Program Guide for more information.
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Stage 2: Configuring speakers

The Speakers configuration stage allows you to set up the digital 

surround controller for the particular arrangement of loudspeakers 

in your system.

To configure the speakers

Either:

• Press Next after resetting the product; see page 18.

Or:

• Press Wizard; see page 17.

• Press Skip to skip past the Reset settings menu.

The display shows the title screen for stage 2:

• Press Enter to proceed or Skip to go to stage 3.

The display shows the first speaker configuration option:

• Press Next or Back to step between options.

A description of each option is shown on the top line of the 

display, and its current value is shown below this to the right.

The options are summarised in the table on the next page.

To change an option

• Press A or V to step between the alternative values for the 

option.

When you have stepped through all the speaker options the display 

shows:

Either:

• Press Next on the last option of the last speaker to proceed to 

configuring sources, as described in the next section.

Or:

• Press On/Off to return to standby.

If you press On/Off before completing the configuration a warning 

is displayed, giving you the option of continuing or abandoning the 

configuration.
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Speaker options
The following table summarises the speaker options:

Option Values Description

Number of Subwoofers: none, one, two, three How many subwoofers.

The main L&R speakers are: small analogue/THX, small DSP, large 

analogue, large DSP

The types of the main left and right speakers. If you have no 

subwoofers, you cannot specify small main speakers.

The Centre is used: always, never, for music, for movies When the centre speaker is to be available.

The Centre speaker is a: small analogue/THX, small DSP, large 

analogue, large DSP

The type of the centre speaker.*

Number of Surrounds: none, two, four The total number of rear and side surround speakers.

The Side speakers are: small analogue/THX, small DSP, large 

analogue, large DSP

The types of the side speakers.*

The Rear speakers are: small analogue/THX, small DSP, large 

analogue, large DSP

The types of the rear speakers.*

The Subs are used: for movies only, always When the subwoofers are used. If you have small main speakers, 

the subwoofer must always be used.

The Sub handles: all the bass, only the LFE Whether to use the subwoofer for all bass or just the LFE channel. 

Only available if there is only one subwoofer.

The bass balance is: neutral, heavy Whether the bass is distributed to all the large speakers and 

subwoofer (heavy) or just the subwoofer (neutral – recommended). 

Only available if there is only one subwoofer, and it handles all the 

bass not just the LFE.

The 2 Subs are used for: Left and Right, Front and Surround If there are two subwoofers, their position. Only available if there 

are two subwoofers.

The sub is: analogue, digital The type of subwoofer(s).

*If you have small main speakers, you cannot specify large centre or surrounds.
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Stage 3: Configuring sources

The digital surround controller provides up to 12 sources 

corresponding to the 12 source keys on the MSR+:

CD, RADIO, DVD, AUX, DISC, TAPE, TV, CABLE, SAT, VCR1, VCR2, 

GAME.

For each source the Configure sources stage allows you to 

configure a series of options, including:

• Whether it is in use.

• The label used for it on the front-panel display.

• The audio input it selects.

• The TRIGGER output level it selects.

The procedure for doing this is as follows.

To configure a source

Either:

• Press Next after configuring speakers; see page 20.

Or:

• Press Wizard; see page 17. 

• Press Skip to skip past the Reset settings and Select 

speakers menus.

The display shows the title screen for stage 3:

• Press Enter to proceed or Skip to go to stage 4.

The display shows the first source and the first configuration option 

for that source, whether it is in use:

• Press Next or Back to step between options.

The top line of the display shows a description of each option, and 

its current value is shown to the right of the source name.

When changing the source name, Next and Back step between 

character positions.

The options are summarised in the table on the next page.

To change an option

• Press A or V to step through the alternative values for the 

option.

To move to the next source

• Press Source.

When you have finished configuring sources:

Either:

• Press Next on the last option of the last source (Game) to 

proceed to configuring settings, as described in the next section.

Or:

• Press On/Off to return to standby.
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Source options
The following table summarises the source options:

Option Values Description

The source is: in use, not in use Whether the source is enabled.

Audio input: D1-D12, MD1-MD2, U1, O2-O5, A1-A8, 

MA1, MA2, Last Valid*

The audio input used for the source; digital, multichannel digital, 

USB, optical, tuner, analogue, or multichannel analogue.

Source name: Any name of up to five characters.

Trigger #1: High, Low, Last Valid Trigger outputs for the source.

Trigger #2: High, Low, Last Valid Trigger outputs for the source.

Trigger #3: High, Low, Last Valid Trigger outputs for the source.

Comms Type: CD 1C, Tuner 2C, DVD 3C, 4C-8C,  

No Comms NC

Set to NC unless the source is a Meridian product.

Comms Address: 1A-8A Allows you to have up to eight of each source type.

*Last Valid leaves the input set to the last input you selected.
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The next stage allows you to configure other aspects of the 

product’s operation.

To configure other settings

Either:

• Press Next after configuring the sources; see page 22.

Or:

• Press Wizard; see page 17.

• Press Skip to skip past the stages 1 to 3.

The display shows the title screen for stage 4:

• Press Enter to proceed or Skip to go to the calibration 

procedure.

The first setting is displayed:

A description of each setting is shown on the top line of the 

display, and its current value is shown to the right of the display.

The settings are summarised in the table on the next page.

To change a setting

• Press A or V to step through the alternative values for the 

setting.

When you have finished configuring the settings:

Either:

• Press Next to proceed to calibrating the system, as described in 

the next chapter.

Or:

• Press On/Off to return to standby.

Stage 4: Configuring other settings
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Settings
The following table summarises the product settings:

Option Values Description

The fan is: used as necessary, never used Specifies how the optional temperature controlled fan 

operates.

Distance measurement: feet/inches, metres Units for displaying and entering distances.

Do your subs play to 20Hz? No, THX Ultra2/yes Subwoofer frequency response.

Boundary Gain Compensation: off, on Reduces the bass to compensate for listening positions close 

to a wall.

Rear speaker separation <12"/0.3m, 12-48"/0.3-1.2m,  

>48"/1.2m

Separation between rear speakers; only available when there 

are four surrounds.

Timeout to Home buttons: on, off Whether the soft keys revert to the home keys after a delay.

Diagnostic displays: on, off Whether diagnostic displays are shown.

Is the C61R IR Controller? Auto, Controller, Not Controller Whether the product is the infra-red controller for the system.

Main System Address 1-8 Advanced setting (normally 1).

Product Address 1-8 Advanced setting (normally 1).

To toggle the IR mode

• If necessary press On/Off to put the surround controller into 

standby.

• Press More.

The display shows:

• Press IR to toggle between IR Auto (auto setup), IR Con. 

(controller), and IR N.Con. (not controller).

After a short delay the surround controller will return to standby. 
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Calibrating the system

Introduction
We recommend that you perform the calibration procedure using 

the MSR+ and from the listening position.

As you run the calibration procedure the name of each calibration 

test is shown on the front-panel display, followed by the 

parameters adjusted in the test.

Each calibration test uses a test signal designed to give the best 

results. 

Using a Sound Pressure Level meter
Although you can perform the calibration procedure by ear, it is 

recommended that you perform the tests using a Sound Pressure 

Level meter. These are available fairly cheaply from Tandy/Radio 

Shack, or your Meridian dealer may be able to lend you one.

Set the Sound Pressure Level meter to C weighted, and Slow. Take 

readings with the meter at the listening position, pointing vertically. 

You should hold the meter with an outstretched arm to minimise 

reflections from your body.

You can choose to display and enter distances in either feet and 

inches or metres.

To help you to set up the installation to give the best possible sound with any particular 

combination of associated equipment, the C61R Digital Surround Controller includes a built-in 

calibration procedure.

This calibration procedure uses test signals to present a series of sounds, which you use to 

adjust certain aspects of the system to their optimum settings.

You should use the calibration procedure the first time you set up the system, and whenever 

you want to check the calibration, such as after changing the layout of the room.
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To start the calibration procedure

Either:

• Press Next on the last option of configuring settings; see page 

24.

Or:

• Press On/Off to put the digital surround controller into standby.

• Press More.

If the product is locked the display shows:

• Press Unlock.

The display shows:

• Press Calib.

The displays shows Please wait….

After a few seconds the display shows the first calibration test:

Left   Level  +0.0dB
 ìî   ïñ  öõú óòô 

Press More for help

For more detailed information about this and the other calibration 

tests see the following sections.

To exit from the calibration procedure

You can exit from the calibration procedure at any time, and any 

parameters you have set will be retained:

• Press On/Off.

To complete the calibration procedure

When you reach the end of the calibration procedure the following 

display confirms that you have completed the calibration of the 

system:

Back  Next Restart

   Calibration complete.

• Press Restart to restart the calibration procedure, or Next to 

complete the wizard.

The display shows:

RestartBack Exit

Press More for help

  Wizard complete

Either:

• Press Exit to return to standby.

Or:

• Press Restart to return to stage 1; see page 18.
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Levels 
These tests allow you to adjust the output level to each speaker 

individually, and it follows the general guidelines from Dolby 

Laboratories and THX.

In each test the display shows the speaker being tested, and the 

current relative level. For example:

Left   Level  +0.0dB
 ìî   ïñ  öõú óòô 

Press More for help

• Use > and < to move between each of the speakers in the 

layout in the sequence: Left, Centre, Right, Side R, Rear R, Rear L, 

Side L, and subwoofers.

• Use A and V to adjust the level of the speaker. Ignore any tonal 

difference. 

For correct THX reproduction you should adjust each speaker to 

75dB SPL using an SPL meter. Even if the speakers are not THX 

approved this setting is recommended.

If you have Meridian DSP loudspeakers they cannot be set above 

+0dB.

Note: You cannot set the level of a subwoofer by ear, because 

low-frequency noises sound quieter. To set the subwoofer correctly 

either use an SPL meter, or set it by ear and then reduce the 

subwoofer gain by 15dB to correct for human hearing.

• When you have completed the Levels section press > to proceed 

to the next test.

Distance
These tests allow you to adjust the delay of each of the speakers in 

the layout to time-align the system so that sounds are coincident 

when they arrive at the listening position.

Before setting up the speaker outputs you need to measure the 

distance to each speaker from the listening position:

CentreSubLeft Right

Left
Side

Right
Side

Left Rear Right RearSurround Sub

Measure from ear height at the listening position to the tweeter 

on each speaker (where applicable), in the distance units you have 

chosen; see Settings, page 25.

Calibration tests
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• Use > and < to move between each of the speakers in the 

layout.

The display shows the speaker being tested, and the distance:

Left   Distance 18'0
Units  ìî   ïñ  öõú óòô 

Press More for help

• Use A and V to change the distance.

• You can press Units to change between feet/inches and metres.

Repeat this for each of the speakers in your layout.

• Press > to proceed to the next calibration stage.

Fine tuning
These tests allow you to fine-tune the phase and delay of each 

speaker when used in conjunction with other speakers on the 

layout.

• Use > and < to move between each of the speakers in the 

layout.

The first display allows you to adjust the phase. For example:

Left   Phase       +
 ìî   ïñ  öõú óòô 

Press More for help

The next display shows the distance for the same speaker. For 

example:

Left   Distance 18'0
 ìî   ïñ  öõú óòô 

Press More for help

• Choose the correct setting as follows:

Setting What it sounds like

Correct The sound between the speakers is very even, and 

does not change radically as you move your head.

Incorrect The sound appears diffused, and changes in timbre 

and apparent location as you move your head.

Pay particular attention to the centre channel, as this can have a 

dramatic effect on the overall sound.

• Press > to proceed to the next calibration stage.
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These tests allow you to determine the bass handling capability 

of subwoofers and large analogue speakers. Once set, the digital 

surround controller will limit the bass level to protect the speakers 

from potential damage. 

On starting the test the speaker sizes are set to zero to avoid the 

possibility of damaging the speakers, and the display shows:

 ìî   ïñ  öõú óòô 

Press More for help

Sizes set to zero

The display then shows the first large analogue speaker; for 

example:

 ìî   ïñ  öõú óòô 

Press More for help

Left   Size    0

• Press A or V to adjust the size value for the speaker until it just 

begins to distort distinctly, and then reduce the value by one. 

• Press > or < to move between each of the speakers to be 

adjusted.

This is the last test in the calibration procedure; see To complete 

the calibration procedure, page 28.

Speaker size
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This section explains how to use the Sine/Sub/Sens controls 

to check for room resonances, adjust the subwoofer crossover 

frequency, or adjust the sensitivity of the analogue sources.

To display the Sine/Sub/Sens controls

• If necessary, unlock the digital surround controller as described in 

Configuration Wizard, page 17.

• Select a source and press More until the bottom line of the 

display shows:

• Press Sine/Sub/Sens.

The bottom line of the display shows the Sine/Sub/Sens controls:

Subwoofer crossover frequency
The C61R Digital Surround Controller allows the crossover 

frequency for any subwoofers which you have to be adjusted 

between 30 and 150Hz. The crossover can be set independently 

for Music, Logic, and 5.1 Movie layouts. The default is the THX 

standard of 80Hz.

To adjust the subwoofer crossover frequency

• Select a source, then display the Sine/Sub/Sens controls as 

described above.

• Press Xovr- or Xovr+ to decrease or increase the crossover 

frequency.

The display shows the current crossover frequency:

Sine -Xover+ -Sens.+

CD    Xover   85Hz

For THX loudspeaker systems you should not adjust these settings; 

they should be left at 80Hz. 80Hz is also the recommended setting 

for all movie listening. You may prefer, however, to lower the 

crossover frequency for music if the main speakers have good bass 

handling down to, say, 50Hz.

Sinewave sweep test
The C61R includes a sinewave signal test, to help you set the 

subwoofer crossover frequencies, or check for room resonances. To 

avoid possible damage to the speakers the volume is reduced to 

50, if necessary, on entering the test.

Warning: This test is very loud. Bass protection is turned 

off during this test, and very loud low-frequency signals 

may damage the speakers.

To use the sinewave sweep test 

• Select a source, then display the Sine/Sub/Sens controls as 

described above.

• Press Sine to turn on the sinewave signal.

Using the Sine/Sub/Sens controls
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The display shows:

Chan  óòô  öõú ExitSound

CD    Sine    80.0Hz

An 80Hz sinewave will be played through all channels.

You can change the test signal using the menu keys, as described 

in the following sections.

To select the channel

• Press Chan.

You can select any individual channel, or All Channels.

To change the sweep rate

• Press A or V to change the sweep rate and direction, as 

follows:

Display Description

Chan  óòô  öõú ExitSound

CD        >>  88.5Hz Fast sweep up.

Chan  óòô  öõú ExitSound

CD         >  81.5Hz Slow sweep up.

Chan  óòô  öõú ExitSound

CD    Pause   80.0Hz Paused.

Chan  óòô  öõú ExitSound

CD         <  78.5Hz Slow sweep down.

Chan  óòô  öõú ExitSound

CD        <<  70.5Hz Fast sweep down.

To change the volume

• Use the volume keys in the usual way.

To change the input

• Press Sound.

You can select between the following inputs:

Option Description

Input The current input.

Sine A sinewave.

Noise Pink noise, band bass 500Hz to 2kHz for main 

channel.

Silent Silence.

Alternatively you can switch between inputs using the menu keys 

on the MSR+.
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Setting up sources
This section explains how to use the Sine/Sub/Sens controls to 

adjust the sensitivity of the analogue sources.

To adjust the sensitivity of a source

To obtain the best signal-to-noise ratio for each analogue source 

you can adjust its sensitivity to give the highest level that does not 

produce clipping.

• Select the source you want to adjust, with loud source material 

playing.

• Display the Sine/Sub/Sens controls as described above.

• Press Sens- or Sens+ to decrease or increase the sensitivity.

The display shows the current sensitivity and the peak level; for 

example:

Sine -Xover+ -Sens.+

TV    1.4V  Peak -3

You can adjust the sensitivity between 0.7, 1.0, 1.4, 2.0, and 2.8V 

(least sensitive).

If the sensitivity is set too high the input will clip the loudest 

passages, and the peak will be 0dB.

The display shows, for example:

Sine -Xover+ -Sens.+

TV    2.0V  Clip -0

In this case reduce the sensitivity by selecting a higher number.

If you have selected a digital source you cannot adjust the 

sensitivity and the display shows, for example:

Sine -Xover+ -Sens.+

DVD   Not Analogue
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Meridian Configuration Program
This chapter explains how to install the Meridian Configuration Program, with a general 

overview of its key features, and then gives complete step-by-step instructions for creating a 

complete configuration for a typical simple system.

Overview
The Meridian Configuration Program is a Windows application that 

lets you design the configuration of your G Series or 800 Series 

products to suit both your own personal preferences and the 

particular configuration of other equipment in your system. 

It uses an intuitive graphical interface that prompts you at every 

stage for the information it needs to complete the system. When 

you have designed the system to your requirements you can save 

the configuration to the appropriate Meridian products in the 

system via a serial link connected to the back of each product.

How it works
The Meridian Configuration Program reflects Meridian’s system 

approach to designing audio products and presents a graphical 

representation of your whole system. It allows you to create a 

single configuration file representing the settings of each product in 

your system and the way they are interconnected. This file is stored 

in the controller of the system for future reference. As well as being 

far more convenient than configuring each product independently, 

this approach also enables the Meridian Configuration Program to 

check that the settings you are proposing are appropriate for the 

particular combination of products in the system.

The Meridian Configuration Program is structured as a wizard; 

it leads you through a series of stages from the Welcome 

page through to the Finish page, which is reached when the 

configuration has been completed. A Breadcrumb Trail below the 

toolbar at the top of the Meridian Configuration Program 

window shows your current position in the sequence of pages and 

allows you to jump back to an earlier page to check a particular 

setting you made.



M e r i d i a n 

C o n f i g u r a t i o n 

P r o g r a m

� �

Benefits of using the Meridian 
Configuration Program
Configuring your system with the Meridian Configuration Program 

offers several important benefits. In particular:

• You can configure the entire system in a single operation.

• It is more convenient and more intuitive than using the front-

panel menus.

• You have access to many advanced configuration options that are 

not available from the front-panel menu.

• You can conveniently edit the names of sources, DSP presets, and 

radio presets using the keyboard.

• You can edit the G Series soft keys.

• If your controller is a C61R, G61R, G68, or 861 you can take 

advantage of Meridian Room Correction.

• You can set up multiple systems far more conveniently than by 

manually configuring each product.

• You can keep a record of the configuration of your entire system 

in a single document on your PC.

If you have made manual adjustments to the configuration of 

a product from the front panel, you can fetch the product’s 

configuration into the Meridian Configuration Program as the 

starting point for the configuration of your system, in order to 

retain the settings, such as calibration settings.

Meridian Control Window
The Meridian Configuration Program is supplied with the Meridian 

Control Window utility, a separate PC application that allows you 

to control any Meridian product via a serial cable (or USB cable 

on certain products) using a simple push button interface that 

emulates a Meridian MSR+ or MSR remote control. Alternatively it 

allows you to submit commands by name, and supply parameters 

for commands that take a value, such as the volume setting.
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The Products page
The following illustration shows the key features of the Products page, which lets you specify how your system is interconnected:

Breadcrumb Trail

Information Bar

Toolbar

Tabs to add new products

Resource Bar

Controller

Sources Speakers
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Requirements
To use the Meridian Configuration Program you need:

• A computer running Windows 95, 98, 2000, NT 4, ME, or XP.

• 10Mbytes of free disk space.

The Meridian Configuration Program communicates with the 

products you are setting up via a serial cable. The computer you are 

using needs to have a nine-pin serial port available, or you can use 

a USB/serial adaptor.

Alternatively some G Series products include a USB port, in which 

case the Meridian Configuration Program can communicate with 

them via a USB cable connected to the computer’s USB port.

The software requires a mouse or similar pointing device – it 

cannot be operated solely from the keyboard.

To install the Meridian Configuration Program

• Insert the Meridian Configuration Program Installation CD-ROM.

The Setup program should run automatically when the CD-ROM is 

inserted. If not, locate setup.exe on the CD-ROM and run it.

The Setup program Welcome page will be displayed.

• Follow the wizard.

On the Preferences page:

• Leave Install for all users selected, unless you want to restrict 

use of the program to yourself on a multi-user machine.

Running the Configuration Program
• Click Start, point at All Programs, Meridian, then click 

Configuration Program:

The Welcome page will be displayed. This provides links to useful 

information.

Installing and running the Meridian Configuration Program
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This section gives complete step-by-step instructions for creating a 

complete configuration for a typical simple system. Even if this does 

not correspond to your own system we recommend you follow 

the tutorial to give you a quick tour of the Meridian Configuration 

Program. 

At each stage the Quick tour shows information in grey tinted 

boxes about the more advanced features of the program, and the 

additional options for configuring 800 Series products.

Using the Meridian Configuration 
Program
The simplest way to use the Meridian Configuration Program is to 

click the links in the Breadcrumb Trail and Information Bar at the 

top of the window; for example:

The Breadcrumb Trail shows a sequence of hyperlinks to pages you 

have already visited; this is indicated by the blue underline. Clicking 

one of the links takes you to the corresponding page to allow you 

to check your settings on that page, or make changes. The last 

entry on the Breadcrumb Trail is usually Next, which takes you to 

the next page.

The Information Bar provides help about the current page, and 

tells you what to do next. The Information Bar contains two types 

of hyperlink: definitions, prefixed by a question mark icon, which 

display a pop-up window with a definition of the item, and jumps, 

prefixed by an arrow icon, which perform an action or jump to 

another page.

Starting a configuration
To start creating a configuration from the Welcome page:

• Click the Next link in the Breadcrumb Trail:

The Products page will then be displayed. This allows you to 

define the products in your system and indicate how they are 

connected together.

Getting help
For more detailed information about the Meridian Configuration 

Program see the on-line help. To display the help:

• On the Help menu, click Configuration Program Help.

Quick tour
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The controller is defined as the product that selects sources and 

controls the volume for the system; it is the digital surround 

controller, preamplifier, or combination product. In this example it is 

a G68 Digital Surround Controller.

• Click the insert a controller link in the Information Bar. 

An Insert dialogue box is displayed to allow you to specify the 

type of controller.

• Select G68ADV from the drop-down list and click the OK button 

to add the product:

You will then be asked whether you want to fetch an existing 

configuration from the controller. If you are starting from scratch, as 

in this Quick tour, you do not need to do this. For more information 

see the Advanced tips on the next page.

• Click the No button to indicate that you do not want to fetch 

data from the digital surround controller:

The Products page will then show a block representing the 

G68ADV Digital Surround Controller:

Products: Adding a controller
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Advanced tips
Adding products by dragging them from the Resource Bar

The most flexible way of adding products is to drag an appropriate 

icon from the Resource Bar (to the left of the Products page) 

onto the Products page:

Fetching settings from a product

If you have changed any settings on a product from the front 

panel since making a previous configuration, you can retain the 

settings by using the Meridian Configuration Program to fetch the 

configuration from the product, rather than starting from a default 

configuration as described above. This is also useful if you cannot 

locate the file on the computer.

• Connect a serial cable between the product and your PC, as 

described in To connect the serial cable, page 56.

• When the Fetch from Product dialogue box is displayed, click 

the Yes button.

Performing other actions

Right-clicking on most objects on the Products page displays a 

context menu of actions appropriate to that object:

For example, to delete a product:

• Right-click the product, then click Delete on the context menu.

Note: If you delete the controller you will need to restart the 

configuration from scratch.

Displaying or changing product properties

Many products provide a range of properties that you can change 

for specific situations. To display the product properties:

• Right-click the product, then click Properties on the context 

menu, or double-click the product.

The Properties dialogue box shows a list of the properties 

associated with the product, and allows you to view or change 

their values:

For detailed information about each of the properties refer to the 

Configuration chapter in the Installation Guide for the product, 

or the FAQs section in the on-line help. To display this, click 

Configuration Program Help on the Help menu.



M e r i d i a n 

C o n f i g u r a t i o n 

P r o g r a m

� �

Changing the value of a property

• Click the value of the property.

• Choose an option from the drop-down list:

If it is a numeric property you will get a spin button rather than a 

drop-down list:

If it is an on/off property you can click the checkbox to change the 

value:

If you have changed the value of a property an asterisk (*) is 

shown after its name.

Reverting a property to its default value

• Right-click the property, then click Revert to Default on the 

context menu:

The menu option shows the default value.

Configuring 800 Series products
Adding an 800 Series controller

If you are adding an 800 Series controller a dialogue box will allow 

you to specify one of the product’s standard card configurations. 

Alternatively select Minimal to add a minimum set of cards at this 

stage, in which case you will be prompted to add further cards as 

you make connections to the product:

Adding cards

You will be automatically prompted to add cards as required 

when you add sources or speakers to the 800 Series product. 

Alternatively you can add cards explicitly if you prefer:

Either:

• Drag the appropriate card icon from the 861 Cards or 800 

Cards tab in the Resource Bar (to the left of the Products 

page).

Or:

• Right-click the product icon, then click Add Card… on the 

context menu:
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The following dialogue box allows you to specify the card type and, 

when appropriate, the position of the jumper identifying the card:

Removing a card

• Right-click one of the outputs on the card, then click Remove 

Card on the context menu.

Displaying the properties of a card

• Right-click one of the outputs on the card, then click the 

Properties item on the context menu.

A Properties dialogue box shows information about the type of 

card, its slot positions, and the jumper setting:

Displaying information about the cards

• In the Properties dialogue box click the Cards tab.

Initially this shows a graphic of the card positions:

To show a list of the cards:

• Right-click, then click Details on the context menu:

This shows a list of the installed cards:

You can also add a card, remove a card, or display a card’s 

properties in the Graphic or Details view by right-clicking, then 

clicking Properties on the context menu.
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Products: Inserting a source

The next step is to add the sources in your system. For this Quick 

tour we will assume a satellite receiver is required.

• Click the insert a source link in the Information Bar.

An Insert Source dialogue box is displayed to allow you to select 

the type of source.

• Choose Satellite from the drop-down list, and click the OK 

button to add the source:

The Connection Wizard is then displayed to assist you in 

connecting the source to your other equipment:

• Leave Yes selected to make the recommended connections 

between the source and the controller.

The Meridian Configuration Program will use a set of connections 

which match the back panel screening of the controller to make 

wiring up straightforward

• Click the Finish button to make the recommended connections.

The connections will be displayed on the Products page:

This shows the audio connection between the satellite receiver 

optical output and the optical input O1 on the digital surround 

controller, and the S-video and component video connections 

between the satellite receiver and the digital surround controller.

You can now proceed to add the other sources in your system in a 

similar way. In this example we are only inserting a single source.

See the Advanced tips on the next page for information about 

modifying these connections; eg to use analogue rather than 

optical for audio. 
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Advanced tips
Showing a list of the recommended connections

• Click the Details… button in the Connection Wizard dialogue 

box.

This shows the connections that will be made if you choose the 

Yes (recommended) option:

Specifying connections manually

• Choose the No (advanced) option in the Connection Wizard 

dialogue box.

• Click the Next button to continue.

• Specify each connection that you want to make from the source 

to the controller, using the From: and To: drop down lists, then 

click the Connect button to make the connection:

• Click the Finish button to close the Connection Wizard 

dialogue box.

Renaming a source

You can give each source a name of up to five characters to 

identify it on the front-panel display:

• Right-click the source, then click Rename… on the context 

menu:

The following dialogue box allows you to enter a new name:

Changing the MSR+ key for a source

You can choose which MSR+ key selects each source:

• Right-click the source, then click Properties on the context 

menu.

• Click the Identification tab in the Properties dialogue box.
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• Choose the MSR+ key from the MSR+ key drop-down list:

Showing and hiding connections

You can choose whether or not source connections are displayed 

by clicking the View or Hide Source Connections button in the 

toolbar:

Displaying information about the style of each  

connection line

• On the View menu, click Legend.

Connecting using drag and drop

You can also connect between any two compatible connectors 

using drag and drop:

• Drag between the output on the source and the input on the 

controller that you want to connect:

When you release the mouse button the cable will be connected:

If the connectors are incompatible a stop cursor will be displayed:

Removing a connection

• Drag from one of the connectors and release the mouse button:

The cable connecting the two products will be removed.



M e r i d i a n 

C o n f i g u r a t i o n 

P r o g r a m

� �

Making a multichannel connection

If you are connecting a product with multichannel outputs, such 

as a G98DH DVD Player, to a digital surround controller with 

multichannel inputs, the Meridian Configuration Program can 

create a multichannel configuration when you drag between two 

appropriate connectors:

A prompt allows you to choose whether to make a single or 

multichannel connection.

If you choose Yes the multichannel connection will automatically 

be made:

Adding or removing inputs or outputs

With non-Meridian sources you can add new inputs or outputs, 

or remove inputs or outputs, to reflect the connectors provided by 

your source. For example, if your satellite receiver includes a digital 

coax output you can add a connector for this:

• Right-click one of the source’s existing connectors, point to 

Connection on the context menu, then click New… on the 

submenu:

The Add Connector dialogue box allows you to define the new 

connector.

• Specify the type of connector using the Class and Type drop-

down list, enter a name, and choose Output or Input as 

appropriate:

• Click the OK button to add the connector.
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Products: Adding speakers

The next step is to add the speakers in your system.

• Click the insert a speaker link in the Information Bar.

The Insert Speaker dialogue box allows you to select which type 

of speaker you want to add, and the positions in which to add it.

• Select DSP8000 from the Type drop-down list.

The Location will automatically be set to Front left/right:

• Click the OK button to add the speakers. 

The speakers will be added to the appropriate points in the layout, 

and the connections will automatically be made between the 

speakers and the controller:

• Click the insert a speaker link again and select DSP5500HC 

from the Type drop-down list to add a centre speaker:

The program will offer to add a 511 patch box to the layout to 

connect the Comms cables for the speakers:

• Click the Yes button to confirm.

• Click the insert a speaker link again and click Analogue 

(passive) on the Type drop-down list to add small analogue 

rear speakers:

• Click the OK button to add the speakers.

The Meridian Configuration Program will automatically prompt you 

to add an amplifier to the layout to drive the passive speakers:
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• Click the Yes button.

• Click G57 on the Amplifier type drop-down list, and click the 

OK button to add the amplifier:

The G57 will automatically be connected up to the appropriate 

analogue output on the digital surround controller:

Finally insert a subwoofer into the layout:

• Click the insert a speaker link in the Information Bar and select 

Subwoofer from the Type drop-down list:

You can proceed to add any other speakers in your layout in a 

similar way.

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.



M e r i d i a n 

C o n f i g u r a t i o n 

P r o g r a m

� 0

Advanced tips
Adding a speaker by dragging it from the Resource Bar

• Drag an icon from the Speakers tab of the Resource Bar (to the 

left of the Products page):

• Drop it onto the appropriate speaker position.

Adding a speaker at a specific position

• Right-click the position, point to Insert on the context menu, 

then click Speaker… on the submenu:

Alternatively, double-click or right-click the speaker position.

Reviewing and printing the source and speaker 

connections

Additional Speaker connections and Controller connections 

pages can be displayed to allow you to check the source and 

speaker connections, or print out a copy for help in wiring up the 

system.

• On the View menu, click Review Pages.

The Speaker connections and Controller connections pages 

will appear in the Breadcrumb Trail after the Soft keys page:

Displaying or changing the speaker properties

To display the speaker properties right-click the speaker symbol, 

then click Properties on the context menu, or double-click the 

speaker symbol:

You can edit the properties in the same way as for source 

properties.
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The Soft keys page allows you to customise the soft keys for each 

of the G Series products in the system, starting with the controller. 

In this example the only applicable product is the G68ADV.

An initial recommended layout is provided for each product; for 

example, for a G68 this provides soft keys for each of the sources 

in the system, plus a DSP key in the rightmost position.

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.

Soft keys
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Advanced tips
Changing the soft key layout

• Drag a soft key, or pair of keys, from the left-hand pane onto the 

set of soft keys you want to edit:

• Hold down c to insert the key(s), moving existing keys right to 

make space.

You can undo or redo changes to the soft key layout by clicking the 

Undo or Redo buttons in the toolbar:

The first 12 soft keys correspond to the 12 MSR+ keys. Only the 

ones corresponding to the sources you have defined in your system 

will be available – the others will be greyed out. Their names will 

reflect the names you have given to the sources on the Products 

page.

Soft keys that work in pairs, such as balance, bass, treble, and 

bright, automatically occupy two adjacent soft key positions. 

Renaming a source

• Right-click a soft key corresponding to a source, then click 

Rename Source… on the context menu:

All occurrences of the source in the soft key sets will be changed.

Clearing a soft key

• Right-click the soft key, then click Remove on the context menu:

Restoring the recommended layout

• Click the Reset button for a recommended assignment of soft 

keys.
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Bass management

Advanced tips
Meridian digital surround controllers allow you to define three 

different speaker layouts for use with different types of material: 

Music, Logic, and 5.1 Movie. The Bass management page 

allows you to specify how the bass is handled in each speaker 

layout:

Specifying which speakers should handle the bass

The Main speakers and Surround speakers sections allow you 

to specify whether each speaker is Large, in which case it will 

handle the bass for that channel, or Small, in which case the bass 

for that channel will be redirected to another speaker. 

You can choose whether the main front and centre speakers are 

specified as Large or Small for each of the Music, Logic, and 

5.1 Movie speaker layouts. 

The diagram to the right of each tab represents the selected 

speaker layout; select Display bass flow to display red arrows on 

the diagram indicating how the bass for each channel is handled by 

the speakers in the layout for either Multichannel or 2-channel 

sources as specified (see below).

Specifying which subwoofers are used in the layout

In the Subwoofers section you can specify how many of the 

subwoofers are used in the layout. Subwoofers used in the 

layout are indicated by a black square in the layout diagram, and 

subwoofers not in use are indicated by a white square. 

If there are no subwoofers in the layout the front speakers must 

be specified as Large, and they will handle the bass for any other 

small speakers in the layout. 

The Bass management page specifies how bass is handled in 

the system for each of the three speaker layouts. The settings are 

automatically set to recommended values and can be ignored for a 

simple configuration.

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.
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If there is one subwoofer in the layout, and you have specified the 

front speakers as Small, the subwoofer will be used for the bass 

and LFE. If the front speakers are Large and the centre speaker is 

Small, the Front subwoofer option allows you to choose from 

the following options:

Option Use of subwoofer

LFE Only * Handles just the LFE. 

Bass-neutral (centre) Handles all the bass. 

Bass-heavy (mono) Shares the bass with the front 

speakers.

* Not available for the Logic layout.

If the layout includes two or more subwoofers, the subwoofers will 

handle the bass and LFE for the system irrespective of the size of 

the front speakers. 

Specifying the crossover settings

For each speaker layout the Crossover option allows you to set 

the crossover frequency for the subwoofers. This is ignored if the 

subwoofers are only handling the LFE.

The Meridian digital surround controllers provide very high-quality 

crossovers for the subwoofers, and for best results you should 

use these instead of the subwoofer’s crossover. To do this set the 

subwoofer Width property to Narrow, and remove any crossover 

in the subwoofer, or set it to the highest setting (eg 200Hz). If 

you cannot do this, set the subwoofer Width property to Wide to 

switch off the digital surround controller’s crossover and use Sine/

Sub mode to match the subwoofer’s crossover frequency.

The LFE low pass filter option sets the low-pass filter for the LFE 

channel, for the Music and 5.1 Movie speaker layouts.

• Click the Reset button to reset the crossover and low-pass filter 

to recommended values in all layouts.

Specifying the THX settings

The THX settings tab allows you to specify that your subwoofers 

are THX Ultra2 approved, and select Boundary gain 

compensation to reduce bass levels if listeners are close to a 

wall. Click the THX Defaults button to set the crossover and low-

pass filter to 80Hz in all layouts, as recommended by THX.
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Speaker distances

The Speaker distances page gathers information about the 

relative positions of the full-range speakers in your system, and the 

distance of each speaker from the listening position. First choose 

the units you would like to work in.

• On the View menu, click Metric or Imperial.

• Measure the distance to each speaker in the specified units.

• Drag the speakers until they are in the correct positions, with the 

correct distance shown on each speaker icon.

This information is used to calculate the speaker delays, and 

generate the aspect ratio and rear speaker separation.

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.

Advanced tips
• Click the A or V buttons to the left of the scale indicator to 

change the scale of the whole diagram.

• Click a speaker to select it, and then use the arrow keys to move 

the speaker in the corresponding direction.

• Use c^ and cV to move a speaker away from or 

towards the listening position. Hold down S to move all the 

speakers at once.

• Use c< and c> to move a speaker in a circle around the 

listening position.

• Click the Scale to Fit button to increase the scale so the 

loudspeakers fit neatly in the window.
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Speaker calibration

The Speaker calibration page allows you to calibrate the 

speakers attached to your controller while listening to the product. 

You can use the Meridian Configuration Program to step between 

speakers, and change the properties of the currently selected 

speaker, using the on-screen buttons.

To connect the serial cable

• Connect one end to the RS232 connector on the back panel of 

the controller in your system.

• Connect the other end to one of the serial ports on your 

computer.

The default is COM1. If you have to use a different port see 

Advanced tips overleaf.

The Speaker calibration page shows a list of the speakers 

connected to your controller and the current distance, level, and 

phase settings of each speaker:

• Click the Start button.

The Meridian Configuration Program stores the settings you 

have created to the controller and then automatically starts the 

calibration sequence so you can tune your speakers by ear using a 

series of listening tests:

• Use the <, >, A, and V buttons on the Speaker calibration 

page to control the product; refer to the appropriate guide for 

your product for details of the calibration procedure.

The product’s display is shown above the arrow keys on the 

Speaker calibration page.

• When you have completed the calibration procedure click the 

Exit button on the Speaker calibration page, or the Off 

button on the product, to fetch the calibration settings from the 

controller.

The calibration settings will be shown in the speaker list on the 

Speaker calibration page.

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.
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Advanced tips
Specifying the serial port

• Click the Options… button on the Pre-calibration store page 

to display the Comms Port tab on the Options dialogue box:

• Select the port you want to use from the drop-down list and click 

the OK button.

A warning triangle will be displayed against the port number if it is 

already in use by another program.
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Room correction

The Room correction page runs the Meridian Room Correction 

procedure. This is optional and you can skip this stage by clicking 

the Next link in the Breadcrumb Trail:

For information about running the Room Correction procedure see 

the chapter Room Correction, page 65.

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.
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DSP presets

The DSP presets page shows a list of the DSP presets available to 

the digital surround controller, and allows you to edit the properties 

of each preset. You can also edit the preset mappings, to change 

the default DSP preset selected for each source and each audio 

format.

For a simple configuration you can skip this page.

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.

Advanced tips
The Preset Properties pane shows the name and value of each 

of the preset properties:

Some properties apply globally to all presets; to edit these select 

All presets in the Preset Properties list.

Displaying and changing the properties for a preset

• Select the preset in the left-hand list.

You can then edit the properties in exactly the same way as for 

product properties; see Changing the value of a property, page 9, 

or Reverting a property to its default value, page 9.

For full information about the parameters for each DSP preset see 

the Installation Guide for your product.

Creating user-defined presets

You can create additional user-defined presets with specific 

properties:

• Right-click the preset you want to use as the basis for the new 

preset, point to Copy to on the context menu, then click New 

Preset on the submenu:

If you have already created one or more user-defined presets, you 

also have the option of overwriting an existing user-defined preset.

Restoring presets to their default values

• Right-click the preset, then click Revert to Defaults on the 

context menu:

• Alternatively click Revert All to Defaults… to revert all the 

built-in and user-defined presets to their default properties.
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Changing the preset mapping

The Preset Mapping pane shows the default DSP preset selected 

for each source and each audio format.

• Click the preset in the appropriate audio format column and 

select the preset you want to use for the default from the drop-

down list:
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For each product in your system that includes a radio tuner, a 

Tuner presets page allows you to define the legend displayed on 

the front panel display for each tuner preset, and the waveband, 

frequency, and audio mode it selects:

• Click the checkbox in the Number column to enable the 

corresponding tuner preset, and edit the Legend, Frequency, 

and Audio Mode as required.

• Set Display Legend to No if you want the display to show 

the RDS station name, or frequency if no RDS station name is 

available, rather than a predefined legend.

When you have edited the tuner presets as required:

• Click the Next link in the Breadcrumb Trail to proceed to the 

next page.

Tuner presets
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Store settings

This page stores the settings to the controller:

• Connect the serial cable.

For more information see To connect the serial cable, page 56.

• Click the Start button to store the settings.

When the store has completed:

• Click the Next link in the Breadcrumb Trail.
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Finish

The Finish page confirms that you have successfully completed the 

configuration of your system.

Save a copy of your configuration 
Although a copy of the configuration document is saved in the 

controller for your system, it is recommended that you also save 

a copy of the final configuration document on your PC, with an 

appropriate name, so that you can refer to it again at a later date, 

if necessary.

• On the File menu, click Save, or click the Save button in the 

toolbar:
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Room Correction

Introduction
The Meridian Room Correction procedure creates a set of one or 

more room correction profiles matched to your room. These are 

then downloaded to the digital surround controller and can be 

associated with particular presets, or selected from the front panel. 

Selecting a profile applies a set of digital filters individually to each 

speaker to achieve the required room correction. 

If you use a single speaker layout you may choose to have one 

room correction profile, and use this with all presets. If you 

have separate speaker layouts for use with Music, Logic, and 

5.1 Movie sources you will need to calculate a separate room 

correction profile for each speaker layout. These will then be 

selected automatically by the digital surround controller depending 

on the audio format. In addition, you can create separate room 

correction profiles to take account of changes to the room, such 

as the position of large items of furniture, or with curtains open 

or closed.

How room correction profiles are 
calculated
Calculating a room correction profile is a time-consuming and 

mathematically complicated process. Meridian Room Correction 

performs the necessary sequence of measurements and 

calculations automatically, using a PC connected to the digital 

surround controller, with the minimum of interaction. It works as 

follows:

First you need to set up a microphone close to the listening 

position, and connect this to an appropriate input on the digital 

surround controller. On the C61R, G61R, or G68 Digital Surround 

Controller this will be A8 (L). On the 861 Reference Digital 

Surround Controller this can be any analogue input; input A1 on 

card IA00 is chosen by default.

Usually a standard sound pressure level meter will be used as 

a microphone; this can be the same one used for setting the 

The C61R digital surround controllers incorporate room correction, which takes advantage 

of advanced digital signal processing techniques to compensate for room artefacts, including 

resonances and reflections, to give a significant improvement in the sound.

This chapter explains how to use Meridian Room Correction to create profiles for use with the 

digital surround controller.
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speaker levels during the Calibration procedure. After an initial 

short test sequence, designed to check that the microphone is 

set up correctly, a test signal is presented to each loudspeaker 

and measured at the microphone to determine how the room 

response affects the sound from each speaker. This stage of the 

procedure takes about one minute per speaker, and can be left to 

run unattended. 

Finally, after a complete set of measurements has been made 

for each channel and speaker layout, the program calculates a 

set of filters for each channel, and stores these to the digital 

surround controller. A copy of the measurements, together with the 

calculated filters in each profile, is also stored on the PC so they 

can be accessed at a later date if required.

Examples
Most domestic rooms tend to be rectangular, or at the very least 

have one pair of parallel facing walls, and unfortunately these are 

the ideal conditions for low frequency resonances within the room. 

The wavelength of low frequency sounds is relatively large, so even 

bookcases and curtains act as an almost perfect mirror for low 

frequencies. 

Frequencies close to the resonant frequency, determined by the 

distance between the two reflective surfaces, will sound louder and 

take longer to decay than other frequencies. In practice this means 

that when listening to music some notes will sound louder, giving a 

roughness or unevenness to the sound.

Other problems that can be corrected by room correction are 

imbalances between the speakers due to positioning constraints. 

For example, in an L-shaped room one loudspeaker may need to be 

close to the wall whereas its partner is in an open area, giving rise 

to an imbalanced sound field. 

Unless your listening room has been specially designed for acoustic 

performance, you will almost certainly hear distinct benefits after 

incorporating room correction into your digital surround controller, 

and if the room has major resonances or imbalances the difference 

should be quite dramatic.

You can find more information about the theory behind Meridian 

Room Correction on the Meridian Web Site at:  

http://www.meridian-audio.com/p_rc.htm
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This section explains how to create a basic room correction using 

default settings.

The room should be as you would normally use it for listening. 

Close/open doors, close/open curtains, and position your screen 

and furniture as they would normally be for listening.

If you are creating room correction profiles as part of the initial 

configuration of your system, follow the procedure described in 

this chapter when you get to the Room correction page in the 

sequence of Meridian Configuration Program pages.

If you decided not to create room correction profiles when you 

first configured the system, start from the saved configuration 

file, or fetch the configuration from the digital surround controller, 

and then step forward to the Room correction page in the 

Breadcrumb Trail:

To set up the room correction options 

The first step is to specify options for the room correction 

procedure. 

• Click the Options… button to display the room correction 

options:

• Specify the sensitivity for the microphone.

When first running room correction it is recommended that you 

leave this at its initial setting.

If you are using an 861 Reference Digital Surround Controller you 

will also need to specify the card and input you are using for the 

microphone.

• Specify the maximum number of measurement retries; by default 

this is set to 3, but you can enter a lower value to reduce the 

time taken by retries.

• Click the OK button to confirm the options you have specified. 

Auto Build 
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• If you are using a C61R, G61R, or G68 Digital Surround 

Controller connect the SPL meter or microphone to the analogue 

input A8 (L).

• If you are using an 861 Reference Digital Surround Controller 

connect the SPL meter or microphone to the analogue input you 

specified in the Options dialogue box.

• Position the SPL meter or microphone at the listening position 

and, if you are using an SPL meter, switch it on.

When using an SPL meter, the C weighting must be used. The 90dB 

range is recommended unless the loudspeakers measured less than 

75dB SPL during the calibration, in which case the 80dB range is 

recommended.

To run the Auto Build procedure

• Click the Start… button.

A countdown dialogue box will give you time to leave the room:

A test tone will then be presented to each loudspeaker in turn 

for each of the distinct layouts defined in the digital surround 

controller configuration file.

Depending on the number of channels and layouts in your 

configuration this may involve up to 24 tests and take up to 20 

minutes to complete.

The Room correction page shows information about each test 

and a progress bar indicates the percentage completed:

When the measurements have been completed the following 

dialogue box allows you to apply the room correction profiles:

• Click the Yes button to assign an appropriate profile to each 

preset. 
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Each preset will be assigned the profile designed for the layout 

used with the preset. The wizard creates profiles called Mus, Log, 

and Mov for the Music, Logic, and 5.1 Movie speaker layouts 

respectively. If two or more layouts share the same settings, the 

profile name will include all the layouts it applies to; for example, 

MusLog or MusLogMov.

What next?
You have now completed the Auto Build procedure, which creates 

a recommended set of room correction profiles. In most situations 

this is all you need to do in order to take advantage of room 

correction with your digital surround controller.

The next sections describe some of the more advanced options 

available on the Room correction page, including the options 

for re-measuring channels, selecting different filter parameters, and 

manually editing the filters.
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The Measurements tab shows a list of the measurement sets you 

have created. Each measurement set shows the channels measured 

for each of the speaker layouts set up in the digital surround 

controller configuration:

You can also create additional measurement sets; for example to 

cater for different furniture layouts. For each measurement you can 

view the effect of applying different profiles.

The Measurements tab gives you the option of viewing 

or comparing the measurements. You can also repeat the 

measurements for individual speakers; for example, if an external 

noise interfered with the test procedure. 

To view the measurements

• Right-click the measurement you want to view, then click View 

Plot on the context menu, or double-click the measurement:

The Plot Measurement window allows you to see the 

measurement for the specified channel:

• Select the profile from the Profile drop-down list.

To show the uncorrected response select Bypassed.

You can compare the effect of two Profile settings on the same 

plot by clicking one of the split pane buttons:

Viewing and repeating measurements
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You can then set different Profile settings for each plot:

You can select one of the following three graph types by clicking 

the corresponding tab. All three views of the measurement are 

calculated from the same measured test signal:

Waterfall plot

Shows the response of the room to a series of short sine wave 

pulses of frequencies between 0 and 250Hz. It shows how the 

response decays over time at each of those frequencies.

The ideal waterfall plot would have a smooth profile and decay 

evenly to a low level within 0.5 to 0.8 seconds. Peaks or dips 

in the waterfall plot indicate resonances or absorption at the 

corresponding frequency. Ridges extending forwards in time 

indicate reverberation at the corresponding frequency. 

The room correction profile aims to identify the strongest 

resonances and to reduce the decay time of each strong resonance 

to the average decay time for the room.

Impulse response

Shows the response over time of the loudspeaker to a click. The 

curve shows a maximum just after time zero, and then decays 

rapidly depending on the amount of reverberation in the room. Any 

additional peaks in the response indicate resonances set up by the 

initial impulse.
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Low frequency response

Shows the loudspeaker-room response to a low frequency sine 

wave, swept between 0 and 250Hz. The ideal low frequency 

response would be smooth. A peak in the response indicates a 

resonance at the corresponding frequency. A dip in the response 

indicates absorption or cancellation at the corresponding frequency.

To display the value of the curve at any point

• Drag to position the vertical red cursor.

The values of the curve at the current point are displayed in the top 

right-hand corner of the plot:

In the Waterfall Plot the values displayed correspond to Time = 0.

To change the axes

• Click the Axes… button to display the axis parameters.

The Data Range section on each tab shows the range of the data 

measured by the Room Correction procedure.

The View Range section on each tab allows you to set the range 

of the Frequency, Level, Time, and Amplitude axes as appropriate 

for each plot:

To repeat measurements

You can repeat measurements for one or more channels; 

for example, if an external sound interfered with an existing 

measurement.

• Right-click the measurement you want to repeat, then click Re-

measure… on the context menu:
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The following dialogue box allows you to select which channels 

you want to repeat:

• Select the channels you want to repeat.

• Click the OK button to confirm your selection.

The following dialogue box warns you that the existing 

measurements will be overwritten:

• Click the Yes button to continue, or the No button to retain the 

existing measurements.

The following dialogue box then indicates how long the selected 

measurements will take, and gives you an opportunity to leave the 

room before the test sequence begins:

To create multiple measurements

You can create additional measurement sets to take account of 

different configurations of the room, such as with curtains open or 

closed.

• Right-click the Measurements tab, then click New on the 

context menu.

A new measurement set will be added to the list, and the 

Speakers to Measure dialogue box will be displayed to allow 

you to specify which speakers you want to measure.

• Click the OK button to proceed with the measurement.

To rename a measurement set

• Right-click the measurement set, then click Rename on the 

context menu, or press 2.

• Edit the name as required and press R.

To delete a measurement set

• Right-click the measurement set, then click Delete on the 

context menu, or select the measurement set and press D.
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The Profiles tab shows a list of the profiles that have been 

calculated, together with the number of filters used for each profile 

and the number of remaining filters available:

Each profile can use up to 60 filters; if a profile requires more 

filters than this, filters will be allocated in order of priority.

Each channel is limited to a maximum of 20 filters; a two-channel 

system therefore has a limit of 40 filters.

To build the filters for a profile

• Right-click the profile in the Profiles list, then click Build… on 

the context menu:

The following dialogue box then allows you to specify a target 

decay time:

• Leave Automatic selected, or click Manual and enter a delay 

time between 100 and 1000 milliseconds.

• Click the OK button to continue.

If you have more than one measurement set the following dialogue 

box is displayed to allow you to select which measurement set you 

want to use for the filters:

Note: The process of building filters is computationally intensive, 

and it is recommended that you do not try to run other programs 

at the same time.

As the filters are calculated the status is shown in the lower half of 

the Room correction page.

To store profiles temporarily to the digital surround 

controller

You can store profiles temporarily to the digital surround controller 

so you can listen to them while using Meridian Room Correction.

• Right-click the profile in the Profiles list, then click Store on the 

context menu.

The lower half of the Room correction page shows the progress 

as the profile is stored to the digital surround controller.

Viewing profiles
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After building the filters for a profile you can edit the filters 

numerically or graphically to adjust their parameters, or change the 

response of each filter. 

Note: This should only be attempted by users with an 

understanding of filter design. It is strongly recommended that you 

copy the profile first and then edit the copied profile. There is no 

undo function within Edit filters.

To display the filters for a profile

• Right-click the profile in the Profiles list, then click Edit… on 

the context menu, or double-click the profile in the Profiles list.

The Edit Filters window shows a numeric or graphical display of 

the filters in the profile.

• Choose a channel from the Channel drop-down list to display 

the filters for that channel, or choose All Channels to show all 

the filters for all channels on a single display.

To view the filters numerically

• Select Numeric.

The columns give the Centre Frequency (Hz), Gain (dB), Filter 

Bandwidth (Hz), Room Mode Bandwidth (Hz), Equalized Bandwidth 

(Hz), RT60 (s), Target RT60 (s), and Channel:

The fields on the left of the filters list allow you to adjust the 

Frequency, Gain, and Width of the currently selected filter.

Editing filters
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To view the filters graphically

• Select Graphical:

To edit a filter

• Select the filter you want to edit by clicking on the filter:

Alternatively if the filters are close together you can step right or 

left between filters using cT or cST.

The currently selected filter is displayed with a red vertical bar 

at the filter centre frequency, and a rectangle indicating the 

bandwidth and gain of the filter.

You can edit each parameter of the filter interactively as described 

in the following sections.

Centre frequency

• Drag the vertical bar to the left or right on the filter response 

curve, or press < or >:

Gain

• Drag the base of the filter, or press ^ or V:
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Bandwidth

• Drag one of the sides of the filter, or press c< or c>:

To add a filter

• Click the Add button on the Numeric or Graphical tab:

• Edit the parameters of the filter as described above.

To delete a filter

• Select the filter you want to delete in the Filters list, or on the 

Graphical tab. 

• Press D, or click the Delete button:
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This section describes how to change the room correction or 

configuration settings of the digital surround controller at a later 

date, subsequent to storing the original version.

Note: You can only edit or add to existing profiles if you have the 

MSL file originally used to design the profile. If you do not have the 

original MSL file you will need to make new measurements, create 

new profiles, and then store these to the digital surround controller.

To edit an existing profile, or add a new profile

• Run the Meridian Configuration Program and open the MSL file 

used to create the original profiles.

If you have changed settings on the digital surround controller 

since the original profiles were made, and you want to retain these 

changes:

• On the File menu, click Save as to save the MSL file under a 

new name.

To fetch the settings from the digital surround controller:

• On the Products page, right-click the controller, then click 

Fetch… on the context menu.

• Step forward to the Room correction page in the Breadcrumb 

Trail.

• Select the Profiles tab, and proceed as described in Editing 

filters, page 75.

To change other settings if you have the original MSL file

• Run the Meridian Configuration Program and open the original 

MSL file.

If you want to keep the original settings:

• On the File menu, click Save as to save a copy of the MSL file 

under a new name.

• Change the settings as required and store the new settings to 

the digital surround controller.

For more information about changing configuration settings using 

the Meridian Configuration Program refer to the Installation Guide 

for your product.

To change other settings if you have lost the original MSL 

file

If the original MSL file is not available you will be able to change 

all non-room correction settings, and which room correction profile 

you want to use with a given preset.

• Start a new document.

• On the File menu, click Fetch… to fetch the settings from the 

digital surround controller.

The newly created file will contain the profile labels and these can 

be used to choose the profile you want to use with a given preset. 

It will not contain measurements or profile data for Meridian Room 

Correction. If you use Meridian Room Correction to create new 

Changing settings at a later date 



R o o m  

c o r r e c t i o n

� �

measurements and profiles and store these to the digital surround 

controller, the old profiles will be overwritten.

• Change the settings as required and store the new settings to 

the digital surround controller.

For more information about changing configuration settings using 

the Meridian Configuration Program refer to the Installation Guide 

for your product.

To change other settings directly on the digital surround 

controller

For information about changing other configuration settings on the 

digital surround controller refer to the Installation Guide for your 

product.

After making changes on the digital surround controller you can 

add these changes to an existing MSL file as follows:

• Run the Meridian Configuration Program and open the original 

MSL file.

• On the Products page, right-click the controller, then click 

Fetch… on the context menu to fetch the new settings from the 

digital surround controller.

If you want to keep the original settings:

• On the File menu, click Save as to save a copy of the MSL file.
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Control Window
The Meridian Control Window emulates an MSR+ to allow you to control a Meridian product 

from a PC via a serial or USB cable. 

Running the Meridian Control 
Window
• Click Start, point to Programs, Meridian, then click Control 

Window:

The Meridian Control Window will be displayed:

This provides the following tabs:

Tab Description

MSR+ Emulates an MSR+ Controller.

MSR Emulates an MSR Controller.

Command Allows you to send predefined commands, and 

optionally specify arguments for the commands, 

and then see the response from the product in a 

terminal-style window.
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Emulating an MSR+ or MSR

To send a command to the product

• Click the corresponding button on the Control Window.

The bar above the buttons shows the response from the product, 

corresponding to the front panel display.

To enter a function key

Either:

• Click the Fn button followed by the button you want to enter.

Or:

• Right-click the button or click the button while holding down 

c.

The legends of the buttons change to show the function options.

To lock the Fn button down

• Click the Lock button:

Subsequent button presses will then enter function keys.

Press the Lock button or Fn button again to release the Lock 

button.

To see the command corresponding to each button

Each button transmits a two-letter code to the product. 

• Point to the button with the mouse pointer.

A tooltip shows the description of the key followed by the key’s 

command:

You can also give commands by typing the key’s command on the 

computer keyboard. Note: Commands are case sensitive.

For example, to select the CD source type CD.

In addition, the following keys on the keyboard provide shortcuts 
for the menu buttons:

Computer key MSR button

^, V, <, > A, V, <, >

R Enter

b (backspace) Return

To disconnect the Control Window

• Click the Disconnect button.

To connect the Control Window

• Select the COM port you want to use from the Port drop-down 

list.

• Click the Connect button.

A warning triangle next to a port number indicates that it is in use 

by another application.

To close the Control Window

• Click the Close button or press E.
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The Command tab lists all the available commands under four 

headings: Source, General, Function + MSR keys, and Preset:

To display the commands

• Click the + button to the left of one of the headings to show the 

commands under that heading.

• Double-click the command you want to send.

To send a command with arguments

• Click the command in the Command list.

You will be prompted for the argument in the box below the 

Command list.

• Enter the argument from the keyboard:

• Click the Send button, or press R, to enter the command.

Using the Command tab
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This chapter gives details of the DSP presets and their parameters, and describes how to 

modify them.

DSP presets

DSP presets
The C61R Digital Surround Controller provides two types of DSP 

preset. One set is available if the input is two-channel; eg from a 

traditional stereo source or a two-channel DVD-A. The other set is 

available if the input is 5.1 or 6 channels of discrete audio; eg from 

a Dolby Digital DVD-V or a music DVD-A. The DSP presets available 

in each set are described in the following pages.

Speaker layouts

The C61R Digital Surround Controller provides great flexibility in 

the way in which you use the loudspeakers in your system. For 

example, the speaker step of the Configuration Wizard allows 

you to use the subwoofers and centre speaker only for movie 

material see Configuring speakers, page 20. With the Meridian 

Configuration Program you can specify three different speaker 

layouts, each with a different use of subwoofers and centre 

speaker:

Layout Description

Music For music presets: two-channel (eg Trifield) and 

multichannel (eg Discrete).

Logic For two-channel movie presets: eg PLIIx Movie.

5.1 Movie For multichannel movie presets: eg Cinema.
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Standard parameters
All DSP presets (except Mono and Direct) provide the following 

standard parameters.

Individual DSP presets provide additional parameters, to allow you 

to adjust specific features provided by that preset. For full details 

refer to information about each preset later in this chapter.

Parameter Range Default What it changes

Treble* -10dB to +10dB +0dB The slope of the frequency response.

Bass* -5dB to +5dB +0dB The bass response.

Phase* + or - + The phase of all loudspeakers.

Axis† -2 to +3 -1 The vertical balance.

Balance <10 to 10> <0> The L-R balance.

HS Output?* Y or N Y Select Y for high-rate audio, upsampled if necessary. Select N for 

standard-rate audio, downsampled if necessary.

Centre -3.0dB to +3.0dB +0.0dB The level of the centre.

Depth -2.5ms to +5.0ms +0.0ms The delay of the centre.

Rear -30dB to +10dB +0dB The level of the rears.

Sides -30dB to +10dB +0dB The level of the sides.

R Delay 0ms to 30ms Varies The delay of the rears.

S Delay 0ms to 30ms Varies The delay of the sides.

LipSync 0ms to 30ms 0ms The sync. delay.

RC As defined Bypassed The Room Correction profile, or Bypassed for no room correction.

*These parameters apply to all DSP presets. 

†Axis is only available with Meridian DSP loudspeakers.
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DSP presets for two-channel material
The C61R provides several signal processing options for two-

channel material. The Music DSP presets are designed for use with 

music from sources such as CD, radio, or two channel DVD-A:

• Music, Trifield, Ambisonics, Super Stereo, Music Logic, PLIIx Music, 

Stereo, and Direct.

The Logic DSP presets are designed for use with film soundtracks 

or TV programmes:

• PLIIx Movie, PLIIx THX, TV Logic, and Mono.

The Music and Logic DSP presets use the Music and Logic speaker 

layout respectively; see Speaker layouts, page 85.

Music

The Music DSP preset extracts the mono and surround components 

of the original recording. These components provide an alternative 

representation of the original sound, and this is sometimes used 

for recording systems or in broadcasts such as FM radio. The mono 

element is equalised using a proprietary Meridian technique to 

match the tone colour of the centre speaker, and to compensate 

for the fact that the frequency response of human hearing changes 

with direction. 

The Music DSP preset is recommended for recordings made with 

spaced omnidirectional microphones, or using a mono-surround 

technique.

Trifield

As for the Music DSP preset, the Trifield preset extracts the mono 

and surround components of the original recording. It then 

calculates the signals for the front, left, centre, and right speakers, 

using the phase and amplitude differences between the three front 

channels, to redistribute the sounds on a frequency-dependent basis. 

This gives a significant improvement over traditional stereo, which 

converts the differences between the microphone signals into 

amplitude differences in the speaker signals. This version of the 

Trifield algorithm is virtually impossible to implement without 

digital signal processing.

Trifield is recommended for well-made recordings and stereo 

television broadcasts that are not Dolby Surround encoded. An 

advantage over the Music DSP preset is that the front stereo image 

is more focused, and the width of the image can be adjusted.

Music and Trifield DSP preset parameters

Parameter Options What it changes

Centre Flat, EQ1-3 The timbre of the centre loudspeaker.

Width† 0-1.5 The width of the image.

Surr. Rear Surr. Rear, Surr. Side, Surr. All Switches the surround signal between the side and rear speakers.

R Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the rear surrounds.

S Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the side surrounds.

†Trifield only.
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Ambisonics

The Ambisonics DSP preset can decode UHJ format, the two-

channel stereo-compatible encoding found on Ambisonically-

recorded discs and broadcasts. This material is specifically encoded 

for surround reproduction and can give breathtakingly realistic 

sound when replayed using the digital surround controller.

Ambisonics surround sound is quite unlike conventional stereo. A 

special microphone technique picks up the sound of the original 

performance in all three dimensions, allowing an archive to be 

made which describes the soundfield exactly at that position. The 

microphone signals are then encoded using a phase-amplitude 

matrix to allow the effect to be conveyed on two-channel carriers 

(like FM radio, LP, or CD).

The digital surround controller uses accurately matched, frequency-

dependent, phase-amplitude matrices to decode the signal and 

construct the signals for each speaker feed.

The fundamental difference between Ambisonics surround sound 

and conventional stereo is that the signals from all the speakers 

combine to produce a coherent soundfield at the listening position, 

giving the illusion that you are sitting inside the recording space 

whether you are at the exact central seat or well off to one side.

Of all the signal-processing options, Ambisonics is the one that 

requires the greatest attention to speaker choice and positioning.

Super

Super synthesises a signal from a conventional stereo recording 

or broadcast so that it can be decoded using the Ambisonic 

decoder. The result is especially effective for two particular types of 

recordings:

• Those using true coincident microphone techniques.

• Multi-tracked or multi-miked recordings.

Ambisonics and Super DSP preset parameters

Parameter Options What it changes

Width* 0 to 1 The width of the image.

Row† A, C, E, G, I, K, M The seating position; the letters are like rows in a hall.

Channels 7, 6, 5, 4 The number of speakers.

R Filter Off, 3kHz, 7kHz, 9kHz The cutoff of high frequencies from the rear surrounds.

S Filter Off, 3kHz, 7kHz, 9kHz The cutoff of high frequencies from the side surrounds.

*Super only. 

†Ambisonics only.
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MusicLogic

MusicLogic is a music DSP preset based on Pro Logic II with 

the addition of user-adjustable steering, designed to provide an 

exciting experience with many types of studio-produced music.

PLIIx Music

The PLIIx Music preset is designed to use the Pro Logic IIx DSP 

processing mode to decode music sources. It provides additional 

Width, Dimension, and Panorama preset parameters to allow 

you to adjust the soundfield.

MusicLogic DSP preset parameters

Parameter Options What it changes

Roll Off, Low, Med, Max The degree of left-right steering. 

Yaw Off, Low, Med, Max The degree of front-rear steering.

Steered All Steered Rear, Steered Side, Steered All Which of the four surround channels are generated by steering.

PLIIx Music DSP preset parameters

Parameter Options What it changes

Steered All Steered Rear, Steered Side, Steered All Which of the four surround channels are generated by steering.

Width 0 to 7 The centre spread, where 0 is full centre and 7 is full left and right. 

Dimension -3 to +3 The spatial soundfield, where -3 puts the balance to the rear of the room 

and +3 puts it to the front.

Panorama No, Yes Extends the front stereo image to include the surround speakers, providing 

a wrap-around effect new to Pro Logic.
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Stereo and Direct

The Stereo preset passes the left and right input signals directly to 

the left and right main speakers. Any mono or front left and right 

subwoofers continue to be used.

With the Direct preset only the left and right main speakers are 

used, bypassing any spatial processing and bass management.

There are no additional DSP preset parameters for Stereo and 

Direct.

PLIIx Movie and PLIIx THX

PLIIx Movie and PLIIx THX use the Dolby Pro Logic IIx DSP 

processing mode, and are the recommended choice for Dolby 

Surround encoded material. They also give excellent results with 

two-channel sources not specifically encoded for Dolby Surround, 

including two-channel Dolby Digital sources.

Pro Logic IIx re-creates 7.1-channel movie surround from the two-

channel source, using improved decoding techniques that preserve 

the directness of the soundfield, resulting in enhanced image 

stability compared with the original Pro Logic decoding. Meridian’s 

implementation of Pro Logic IIx uses proprietary code based on 48-

bit precision to give outstanding clarity.

The PLIIx THX DSP preset uses the same PLIIx processing as PLIIx 

Movie, but adds THX Cinema processing. THX is a set of standards 

and technologies developed by Lucasfilm Ltd. with the aim of 

making your experience of the film soundtrack as faithful as 

possible to what the director intended.

Re-equalistion is used to restore the correct tonal balance for 

watching a film soundtrack in a small home environment.

Timbre matching filters the information going to the surround 

speakers so that they more closely match the tonal characteristics 

of the sound coming from the front speakers. This ensures seamless 

panning between the front and surround speakers.

THX can also be used with the 5.1 Movie DSP presets; see THX, 

page 93.

PLIIx Movie and PLIIx THX DSP preset parameters

Parameter Options What it changes

Surrounds Rear, Side, All Which of the four surround channels are generated by steering.

Pro Logic Off, On On selects an emulation of the original Pro Logic decoding. 
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TV Logic

TV Logic is a Logic preset based on Pro Logic IIx with the addition 

of user-adjustable steering, designed to give higher intelligibility 

and a more appropriate spatial presentation for studio-based TV 

material.

Mono

In the Mono DSP preset you can choose to listen to:

• Only one of two input channels, such as when different 

languages or material are carried on each channel.

• A combined version of the two input channels, such as if the 

material was originally mono and has been conveyed on a two-

channel carrier.

If Party? is set to No, the combined or selected signal is played 

only through the centre speaker, or the left and right speakers if 

there is no centre, to centrally localise high-frequency hiss and 

clicks.

Note: If Party? is set to Yes, full range bass is played through any 

speakers that are not supplemented by a subwoofer, and this may 

damage small speakers at high volume levels.

TV Logic DSP preset parameters

Parameter Options What it changes

Roll Off, Low, Med, Max The degree of left-right steering. 

Yaw Off, Low, Med, Max The degree of front-rear steering.

Surrounds Rear, Side, All Which of the surround channels are generated by steering.

Mono DSP preset parameters

Parameter Options What it changes

Input Auto L+R, Input L, Input R, Input L+R The channel selected.

Academy Off or On Select On to include an equalisation (recommended by Lucasfilm Ltd) to 

correct for a high-frequency balance in some old mono films.

Party? No or Yes Select Yes to play the mono signal through all speakers, including 

subwoofers.
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DSP presets for multichannel material
Multichannel audio signals can come from either encoded data 

streams (such as Dolby Digital) or as discrete channels from a DVD 

player. If you are using Meridian SmartLink then all formats will 

reach the C61R as discrete channels. With suitable loudspeakers 

the C61R can upsample these to provide a more enjoyable 

surround experience.

The C61R Digital Surround Controller will automatically select the 

right decoder algorithm and present the same set of preset choices 

for all streams. Note: Some presets are only available if there are 

four surround speakers in the system.

There are four multichannel Music presets:

• Discrete, PLIIx Mus6, THX Music, and Ambisonics B format 

(discrete inputs only).

There are five multichannel Movie presets:

• Cinema, PLIIx Mov6, THX, THX Surround EX, and THX Ultra2 

Cinema.

The multichannel Music presets all use the Music speaker layout 

and the multichannel Movie presets all use the 5.1 Movie speaker 

layout; see Speaker layouts, page 85.

Cinema

The Cinema preset is recommended for listening to multichannel 

movie soundtracks when no further processing is required. 

Discrete

The Discrete preset is similar to Cinema, except that it uses the 

Music speaker layout and sets the LFE level to -10dB.

Discrete and Cinema DSP preset parameters

Parameter Options What it changes

2+2+2* Off, 5.1, Side, 7.1 Allows you to specify how DVD Audio channels 3+4 should be interpreted: 

Off ignores them, 5.1 and 7.1 use them for centre and LFE, Side uses 

them for the side speakers, 7.1 adds side speakers to 5.1.

Surround† Surr. Rear, Surr. Side, Surr. All Allows you to specify which speakers the surround channels should be 

sent to in a system with four surrounds.

R Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the rear surrounds.

S Filter Off, 1kHz, 3kHz, 7kHz The cutoff of high frequencies from the side surround.

LFE -28dB to 0dB The relative level of the LFE bass channel.

*Discrete only. 

†Cinema only.
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THX

As with the PLIIx THX DSP preset, THX re-equalises the signals to 

suit domestic listening conditions, and applies frequency-response 

correction and decorrelation to the surround channels to make the 

surround sound more realistic. It can be used whether or not your 

other equipment is THX approved.

PLIIx Mov6, THX Surround EX, PLIIx Mus6, THX Ultra2 

Cinema, and THX Music

These presets are available if you have four surround speakers. They 

use Dolby Pro Logic IIx, Dolby Surround EX, and THX Ultra2 Cinema 

processing to generate multiple signals for larger home theatres.

PLIIx Mov6 uses extended PLII technology from Dolby to generate 

four surround signals from traditional multichannel source material 

like Dolby Digital 5.1. It is intended for use with movie soundtracks.

PLIIx Mus6 also creates four surround signals; it is intended for 

multichannel music playback from sources such as DVD-A or SACD 

music discs.

THX Ultra2 Cinema and THX Music use a THX proprietary process 

called advanced speaker array to provide a mix of ambient and 

directional surround sounds using four surround speakers. Optimum 

performance of THX Ultra2 Cinema and THX Music is produced 

when the two rear speakers are placed close together behind the 

listening position. THX Ultra2 Cinema is recommended for movie 

soundtracks that are not Dolby Surround EX encoded, and THX 

Music is recommended for listening to multichannel music.

PLIIx Mov6, THX Surround EX, PLIIx Mus6, THX Ultra2 Cinema, and THX Music preset parameters

Parameter Options What it changes

LFE -28dB to 0dB The relative level of the LFE bass channel.

THX DSP preset parameters

Parameter Options What it changes

Surround Surr. Rear, Surr. Side, Surr. All Switches the surround signal between the side and rear speakers.
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Ambisonics

The Ambisonics preset allows you to decode multi-channel sources 

which have been encoded in Ambisonics B format. 

Ambisonics B format contains four independent channels of 

information to give a three-axis representation of the sound at the 

recording position. The signals are: mono sound pressure, left-right 

velocity component, front-back velocity component, and up-down 

velocity component. 

Using dynamic range control

If the input format is Dolby Digital, the 5.1 Movie DSP presets 

provide an additional Compress parameter to allow you to take 

advantage of the dynamic range information provided in the 

Dolby Digital format to provide dynamic range control without the 

distortion involved in analogue methods. 
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The C61R Digital Surround Controller allows you to modify any of 

the built-in presets, and save them for future use.

You can either save the changes to the built-in preset, or you can 

create up to 10 presets of your own, with names of your choice, so 

you can use them alongside the built-in presets. 

To save the preset settings

• Make sure the menus are unlocked; see To run the Configuration 

Wizard, page 17. 

• Press DSP to select the preset you want to modify.

• Change the preset parameters to the values you want to store.

• Press More then Store, or Function + Store on the MSR+.

The display shows the next available user-defined preset. For 

example:

Store   öõú óòô 

Pick Preset
to overwrite

      User 1

• If you want to overwrite an existing user-defined preset press A 

to select the preset you want to overwrite. 

For example:

Store   öõú óòô 

Pick Preset
to overwrite

      Classical

Alternatively press V to choose the built-in preset you started 

with. For example:

Store   öõú óòô 

Pick Preset
to overwrite

      Trifield

• Press Store.

The settings have been stored in the new or existing preset you 

selected. 

If you are defining a user preset you can now edit the name of the 

preset if you wish.

A flashing cursor shows the letter you are editing:

 ìî   ïñ  óòô Store öõú

Write label
for preset

      User 1

• Press > or < to select the character position you want to edit.

• Press A or V to change the character.

Each press steps through the sequence A to Z, a to z, 0 to 9, full 

stop, and blank. You can also select a blank directly by pressing 

Clear on the MSR+.

Defining your own presets
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For example, you could change the name to:

 ìî   ïñ  óòô Store öõú

Write label
for preset

      Concert

• When you have entered the name you want to use press Store.

The display shows:

 Stored
 ìî   ïñ  óòô Assign öõú

To make the new preset the default for the current source and 

audio format:

• Press Assign.

To clear a user-defined preset

• Make sure the menus are unlocked; see To run the Configuration 

Wizard, page 17. 

• Press DSP to select the preset you want to clear.

• Press More then Clear, or Function + Clear on the MSR+.

The display shows Preset Clear.

If you clear a preset that was saved over a built-in preset, the 

original settings are restored.
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Troubleshooting
We expect you to achieve superb results with your digital surround controller. If, however, you 

encounter any problems, either when installing and configuring it, or during operation, please 

check the following pages for suggested solutions.

If these suggestions fail to cure the problem, please contact your Meridian dealer for further 

assistance.

General operating problems
Standby light not lit

• Check that the AC power supply is connected correctly.

• Check that the ON OFF switch on the back panel is in the ON 

position.

If the light still does not illuminate, check any fuses in your power 

supply and the fuse in the inlet of the C61R. If these are all intact, 

contact your dealer.

Erratic or unexpected system behaviour

Redo the Auto Configure process as follows:

• Put the whole system into standby.

• Make sure you are operating the MSR+ from a position where all 

the units can receive the infra-red.

• Press Clear on the MSR+.

• Observe all units responding correctly.

In extreme cases, the memory of the C61R may have been 

corrupted. If this is suspected perform a full reset; see Resetting the 

product, page 18.
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Remote not working

Check the following:

• The battery in the MSR+.

• Remove the Comms connections from the C61R and check 

whether it responds now. If so, replace the connections and 

perform an Auto Configure procedure; see To connect to other 

Meridian C Series, G Series, or 800 Series equipment, page 15.

• See if the C61R has been set up as Not Controller in the 

Configuration Menu; see Configuring other settings, page 24.  

Note: This may be deliberate by your dealer.

When playing a Dolby Digital DVD, the C61R selects a 

two-channel preset

DVDs include a two-channel Dolby Digital soundtrack, which will 

use the default two-channel preset.

• Select a six-channel soundtrack, if it is available.

Unit is overheating

Check that there is adequate ventilation around the unit.

Audio problems
Hum on analogue input

• Check the source equipment. Disconnect each source in turn.

• If the hum originates from a ground loop, an antenna or cable 

supply may be the cause. In this case an antenna-lead isolator 

should be fitted.

• If the C61R seems to be the cause of hum consult your dealer.

There is radio interference

The C61R is a digital audio and computing device which has been 

designed to very high standards of electromagnetic compatibility.

If this equipment does cause or suffer from interference to/from 

radio or television reception then the following measures should 

be tried:

• Reorient the receiving aerial (or antenna) or route the antenna 

cable of the receiver as far as possible from the C61R and its 

cabling.

• Ensure that the receiver uses well-screened antenna cable.

• Relocate the receiver with respect to the C61R.

• Connect the receiver and this product to different AC outlets.

• If the problem persists contact your dealer.

Sound not clear

• If speech sounds muffled in a system with a centre speaker, 

check that sound is coming from the centre as there may be a 

connection problem. In a digital or Meridian feed to the centre 

you may have set it up to be right instead of left so that it is 

playing a subwoofer signal.
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• If speech sounds muffled in a system with no centre speaker, you 

may have selected a layout that expects one. See Configuring 

speakers, page 20.

Audible hiss at high volume settings

The input dynamic range of most current recordings is at maximum 

16 bit. The reason for this is that currently CD, DVD, and LaserDisc 

use a 16-bit standard, although DVD can support up to 24-bits. The 

analogue sources you have cannot achieve this kind of range. For 

comparison, analogue sources are likely to be of the order of:

• VCR, 12 bits.

• FM radio, 13 bits.

• Reel to reel tape, 13 bits.

• Cassette tape, 12 bits.

• LP, 11 bits.

Note: There may be a difference between the dynamic range of 

the source channel when it is operating, and the noise you hear 

in standby. For example, LP normally has lower noise when the 

stylus is not in the groove; similarly tape will be quieter when it is 

stopped. CD may also be quieter when it is stopped, producing so 

called ‘digital silence’.

The C61R has a 24-bit capability on its internal analogue-to-digital 

converter, which is used for analogue sources. When the volume is 

turned up high you may hear its dither as a hiss when the sources 

are stopped. This hiss is lower than the background noise of your 

recordings and should be of no consequence.

Centre not working

There may be a connection problem.

• In a digital or Meridian feed to the centre, you may have set it 

up to be right instead of left, and therefore it may be playing a 

subwoofer signal.

There is a hiss when starting DTS LaserDiscs or CDs

The DTS audio stream is indistinguishable from a PCM audio 

stream; the C61R takes 30ms to identify the encoding, during 

which a hiss is heard.

• With non-video DTS sources you can add a 30ms delay to avoid 

this.

• With video sources you can create a DTS-only source to avoid any 

hiss.

For more information about each of these options see Meridian 

Configuration Program, page 35.

The preset changes unexpectedly with a multichannel 

source

If you are using a non-Meridian source on the MHR SmartLink 

input, proprietary data may cause preset switching.

• Select Force this source to be six-channel for the source. See 

Meridian Configuration Program, page 35.
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Room Correction problems
This section gives suggested solutions to typical problems that 

may occur when using Meridian Room Correction. If problems 

still persist after working through the following steps please send 

an email to support@meridian.co.uk with a zip file containing 

your MSL file. Please also supply details of the loudspeakers and 

amplifiers you are using.

Failed microphone/SPL meter test

During the first measurement a microphone test is performed 

to ensure that the power and SNR (signal to noise ratio) are 

acceptable. The larger the SNR the better the measurement. 

The following sections describe some of the most likely problems 

which will cause the power and SNR values to go outside these 

ranges.

Power result “Bad”

This indicates that there is very little or no signal on the connector 

you have chosen as your microphone input.

• Check that there was sound from the front left speaker during 

the test.

If in doubt, repeat the measurement. If there is still no sound check 

the connections from the digital surround controller to the left 

loudspeaker. Switch the digital surround controller off and then 

on again, select Calibrate as described in the installation guide 

for your digital surround controller, and check that the left speaker 

plays the calibration signal.

• Ensure that the lead from the SPL meter is intact.

• Check that the SPL meter is switched on and set to the 90dB 

band, or the band which includes 90dB, and with C weighting.

If the loudspeakers measured less than 75dB SPL during the 

calibration phase it may be better to use the 80dB range.

• Check that the lead from the SPL meter is connected to the 

correct input,  

A8 (L) on the G68.

• Ensure that the Sensitivity setting is adequate for the SPL meter 

or microphone.

The sensitivity value for analogue inputs is given in rms volts 

(Vrms). For example, a sensitivity of 1Vrms allows a signal of 

2.8Vpp. A sensitivity of 1V is recommended for use with most SPL 

meters though 0.7V may be preferable for those with lower level 

output.

Power OK, SNR result “Bad”

The most likely cause of this problem is that an analogue source is 

connected to the input chosen for the microphone. 

• Check that the lead from the SPL meter is connected to the input 

you have chosen for the microphone test. 

Another possibility is that the lead from the SPL meter is in bad 

condition and only making a poor connection.
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Power OK, SNR result “Poor”

The reasons for this are described in detail in the following section 

where example measurements are also shown.

Repeated measurements due to poor SNR

Measurements are retried until the SNR is acceptable or the 

maximum number of retries has been completed. The maximum 

number of times each measurement will be retried due to poor 

SNR can be set in the Preferences dialogue box, accessed from 

the Options menu:

The default number of retries is 3. If the measurements are 

consistently giving poor SNR figures you can reduce the number of 

retries. However, it is better to follow the steps described below to 

improve the measurement conditions. The better the measurement 

the more accurate the results when calculating the filters for a 

profile.

SPL meter is set on a low band

The following graph shows an impulse response obtained when a 

Radio Shack SPL meter was set on the 60dB band. The SNR value 

was “Poor”:

SPL meter is set on a high band

The following graph shows an impulse response obtained when a 

Radio Shack SPL meter was set on the 120dB band. The tail of the 

response is generally noisy. The SNR value was acceptable but the 

power was “Bad”:
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Loudspeaker is running in a non-linear range

The effects of a loudspeaker running in a non-linear range is most 

easily observed in the impulse response. The tail of the response 

has small spikes, as shown in the plot below, where it should be 

zero. The larger these spikes are relative to the largest value at the 

beginning of the impulse response the smaller the SNR value:

• Check that the bass protection size has been correctly set – see 

the Installation Guide for your product.

• Check that the bass drive unit in your loudspeaker is not rubbing.

• Check that your amplifier is not clipping.

If problems are still encountered, use the Speaker calibration 

page to reduce the gain of the channel. Use the reduced gain 

setting for the room correction measurements, then return to the 

correct level for a calibrated system after running room correction 

measurements.

Hum in the system

The effect of hum on the measurement is most easily observed in 

the waterfall plot. The continuing signal at 50Hz and 150Hz in the 

waterfall plot shown below indicates a mains hum loop:

You are likely to have heard this level of hum when playing 

analogue sources connected to the same analogue input card as 

the microphone/SPL meter. 

In order to get a better measurement disconnect analogue sources 

from the analogue input card used for the room correction 

measurements. Reorganise your speaker wiring to remove the hum 

loop. 

Hum may also be picked up by the lead from the microphone/SPL 

meter. It is best to use a shielded cable to reduce the chances of 

picking up hum.
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Maintenance

Cleaning
To clean the case, display panel, and keypad

• Disconnect the power cord before cleaning the unit.

The exterior surfaces of Meridian G Series products are made from 

solid anodised aluminium, powder coated steel, thermoplastic 

rubber, and glass.

They are designed to be easily wiped clean with a dry, lint free 

cloth. Greasy marks should be removed by light rubbing with a 

slightly damp cloth and a trace of proprietary glass cleaner. Do not 

use any other solvent or abrasive based cleaners. 

Ensure that no liquid enters the casework and that the product is 

completely dry before re-connection.

To clean the audio and video connections

The audio and video sockets on the back of the product are gold 

plated and do not need to be cleaned if gold-plated phono plugs 

are used. Otherwise, it is recommended that you unplug and 

reconnect the plugs at least once a year. A proprietary contact 

cleaner can be used to some advantage.

The electrical digital output should be treated in a similar way.

To change the mains fuse

• Remove the mains connector, and pull out the drawer above the 

power input to access the fuse.

Before replacing a blown fuse, it is best to ascertain the cause of 

the failure.

The fuse drawer includes a spare fuse. This should be replaced by a 

fuse of the same rating.
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Service and guarantee

Service
The Meridian C Series of hi-fi components has been carefully 

designed to give years of untroubled service. There are no user-

serviceable parts inside the case, nor do the units require any form 

of maintenance.

In the unlikely event that your product fails to function correctly, 

it should be returned, in its original packaging, to your Meridian 

dealer.

In case of difficulty within the UK or USA please contact the 

appropriate sales and service address shown on page iv.

In case of difficulty outside the UK or USA, contact the importing 

agent for the territory. A list of Meridian agents outside the UK is 

available from Meridian Audio.

No responsibility can be accepted for the product whilst in transit 

to the factory or an agent, and customers are therefore advised to 

insure the unit. When seeking service under guarantee, proof of the 

date of purchase will be required.

Guarantee
The product is guaranteed against defects in material and 

workmanship for two years from the date of purchase.

The guarantee is void if the product has been subject to misuse, 

accident, or negligence, or has been tampered with or modified 

in any way without the written authorisation of Meridian Audio 

Limited. Note: Connecting anything other than the correct network 

lead to the Comms sockets may cause damage to the product 

which will not be covered by this guarantee. Attempted servicing 

by unauthorised people may also invalidate this guarantee. Labour 

and carriage charges are not covered unless by local agreement. 

Outside the UK, local warranty liability is restricted to equipment 

purchased within the territory. Our agents outside the UK are only 

under contractual obligation to service under-guarantee equipment 

sold through them. They are entitled to make a non-refundable 

charge for any service carried out on other equipment.

This guarantee does not limit your statutory rights within the 

country of purchase.
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saving  63

starting  39

configuration, resetting  18

Configuration Wizard  17

configuring

settings  24

sources  22

connections

audio inputs  6

audio outputs  10

cleaning  103

communications  14

drag and drop  46

Index
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connections (continued)

making automatically  44

making manually  45

multichannel  47

Connection Wizard  44

controller

adding  40

properties  41

Controller, setting  15

Control Window  81

crossover settings, subwoofers  54

D
Depth (DSP parameter)  86

digital source, connecting  7

Dimension (DSP parameter)  89

Direct (DSP preset)  90

Discrete (DSP preset)  92

DSP parameters

Academy  91

Axis  86

Balance  86

Bass  86

Centre  86, 87

Channels  88

Compress  94

Depth  86

Dimension  89

HS Output?  86

DSP parameters (continued)

Input  91

LFE  92

LipSync  86

Panorama  89

Party?  91

Phase  86

Pro Logic  90

RC  86

R Delay  86

Rear  86

R Filter  87, 88, 92

Roll  89, 91

Row  88

S Delay  86

S Filter  87, 88, 92

Sides  86

Steered All  89

Surr. Rear  87

Surround  92, 93

Surrounds  91

2+2+2  92

Treble  86

Width  87, 88

Yaw  89, 91

DSP presets  59

Ambisonics  88, 94

Cinema  92

clearing  96

Direct  90
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DSP presets (continued)

Discrete  92

editing  59

Mono  91

multichannel  92

Music  87

MusicLogic  89

PLIIx Mov6  93

PLIIx Movie  90

PLIIx Mus6  93

PLIIx Music  89

PLIIx THX  90

preset mapping  60

standard parameters  86

Stereo  90

Super  88

THX  92, 93

THX Music  93

THX Surround EX  93

THX Ultra2 Cinema  93

Trifield  87

two-channel  87

user-defined  59

user-defining  95, 96

DVD-Audio player, connecting to  8, 9

dynamic range control  94

F
fetching settings from a product  41

filters, editing  75

G
guarantee  104

H
help, on-line  39

HS Output? (DSP parameter)  86

I
impulse response  71

Information bar  39

Input (DSP parameter)  91

inputs, adding  47

installation  38

L
layouts

5.1 Movie  85

Music  87

LFE (DSP parameter)  92, 93

LipSync (DSP parameter)  86

low-frequency response  72

M
mains fuse, changing  103

measurements

displaying  70

multiple  73

repeating  72
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Measurements tab  70

Meridian DSP loudspeakers, connecting to  11

Mono (DSP preset)  91

MSR/MSR+ emulating  82

multichannel connections  47

Music (DSP preset)  87

MusicLogic (DSP preset)  89

O
Options dialogue box  57

outputs, adding  47

P
Panorama (DSP parameter)  89

Party? (DSP parameter)  91

Phase (DSP parameter)  86

PLIIx (DSP preset)  90

PLIIx Mov6 (DSP preset)  93

PLIIx Movie (DSP preset)  90

PLIIx Mus6 (DSP preset)  93

PLIIx Music (DSP preset)  89

PLIIx THX (DSP preset)  90

presets

multichannel  92

standard parameters  86

two-channel  87

user-defining  95

printing connections  50

products, displaying properties  41

Products page  37, 39

Pro Logic (DSP parameter)  90

properties, displaying or changing  41

R
RC (DSP parameter)  86

R Delay (DSP parameter)  86, 89

Rear (DSP parameter)  86

requirements  38

R Filter (DSP parameter)  87, 88, 92

Roll (DSP parameter)  89, 91

Room Correction  65

Auto set up  67

changing settings  78

filters  74, 75

profiles  65

room correction  2, 86

Room Correction Store page  58

Row (DSP parameter)  88

S
safety warnings  ii

S Delay (DSP parameter)  86, 89

settings  25

configuring  24

fetching  41

storing  62

S Filter (DSP parameter)  87, 88, 92

Sides (DSP parameter)  86
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Sine/Sub/Sens controls  32

Sine/Sub/ Sens menu

sources  34

sinewave sweep test  32

soft keys

changing layout  52

clearing  52

defining  51

Soft keys page  51

Sound Pressure Level meter  27

sources

adding  44

adding inputs or outputs  47

changing MSR+ key  45

options  23

properties  41

renaming  45

reviewing connections  50

sensitivity  34

setting up  34

sources, configuring  22

Speaker distances page  55

speaker layouts  85

speaker layouts, defining  53

speakers

adding  48

calibrating  56

configuring  20

defining distances  55

options  21

properties  50

speakers (continued)

reviewing connections  50

setting up  31

specifications  3

Steered All (DSP parameter)  89, 90, 91

Stereo (DSP preset)  90

Store settings page  62

subwoofer crossover frequency  32

subwoofers

connecting to  13

crossover frequency  32

crossover settings  54

setting up  53

THX settings  54

Super (DSP preset)  88

Surr. Rear (DSP parameter)  87, 92, 93

Surrounds (DSP parameters)  91

T
THX (DSP preset)  92, 93

THX Music (DSP preset)  93

THX settings  54

THX Surround EX (DSP preset)  93

THX Ultra2 Cinema (DSP preset)  93

Treble (DSP parameter)  86

Trifield (DSP preset)  87

troubleshooting  97

2+2+2 (DSP parameters)  92

Types  18, 19
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U
UHJ format  88

USB audio input  6, 8

user-defined presets  95

clearing  96

editing name  95

W
waterfall plot  71

Welcome page  38

Width (DSP parameter)  87, 88, 89

Y
Yaw (DSP parameter)  89, 91


